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概要

ParaViewは、大容量のデータセットを並列に分析および可視化することのでき
る、パワフル、オープンソース、かつダウンロード後即座に使用可能なアプリケー
ションです。ParaViewはRed StormやASC Purpleスーパーコンピュータによるシ
ミュレーション結果の可視化のために、サンディア国立研究所のアナリストによっ
て日常的に使用されており、さらにその他の、世界中の何千ものユーザによっても
使用されています。柔軟な設定・拡張が可能であり、またスケーラブルな設計を目
指し、ParaViewは Visualization Toolkit (VTK)の上に構築され、それゆえ可視化
コンポーネントの迅速な適用が可能です。このチュートリアルでは、ParaViewの
構造および並列可視化の基礎を学びます。実践的な演習によって、読者が科学デー
タ可視化のための ParaViewの使用法の基礎を学ぶことを目的としています。この
チュートリアルは、現在のスーパーコンピュータで実行されるような大規模シミュ
レーションを可視化するための詳細な方法、およびParaViewにおけるスクリプティ
ングおよび拡張法を特に取り上げます。
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1

第1章 序

ParaViewは、2次元および 3次元データセットを可視化するためのオープンソー
スアプリケーションです。ParaViewが扱えるデータセットの大きさは、ParaViewが
実行されるプラットフォームのアーキテクチャによって大きく変わります。ParaView

によってサポートされるプラットフォームは、シングルプロセッサのワークステー
ションから、多数のプロセッサによって構成される分散メモリスーパーコンピュー
タやワークステーションクラスタまで、多岐に渡ります。並列コンピュータを利用
することで、ParaViewは巨大なデータセットを並列に処理し、その後で処理結果を
集約することができます。今までのところサンディア国立研究所では、最大で 60億
セルの構造化メッシュ、2億 5千万セルの非構造メッシュ、そして数十億のセルから
なる構造AMR格子の可視化に ParaViewを使用しています。

ParaViewの設計においては、以下のような多くの特徴により、他の科学データ可
視化ソリューションとの差別化を図っています。

• オープンソース、スケーラブル、かつマルチプラットフォームな可視化アプリ
ケーション。

• 大容量データセットを処理するための分散型計算手法のサポート。

• オープン、柔軟かつ直感的なユーザインターフェイス。

• オープンな規格に基づいた拡張性の高いモジュール化構造。

• 有償の保守およびサポート。

ParaViewは世界中の多くの学術、公的、および商業機関によって利用されてお
り、毎月およそ 3千件ダウンロードされています。
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ParaViewとしてユーザから見えるアプリケーションの実体は、ParaView自体の
機能を構成する何層ものライブラリ群の上に構築された、小さなクライアントに過
ぎません。上の図に示すように、ParaViewのほとんどの機能はライブラリとして実
装されているため、ParaViewのGUIをカスタムアプリケーションによって完全に
置き換えることが可能です。さらに、ParaViewに付属する pvpythonアプリケー
ションによって、Pythonスクリプトを用いて可視化とポストプロセッシングを自動
化することが可能です。

ParaViewアプリケーションのそれぞれに対し、コードを最大限に共有化するため
のユーザインターフェイス部品のライブラリが利用可能です。ParaViewサーバ・
ライブラリによって、並列かつインタラクティブな可視化を実行するための抽象化
レイヤが提供されます。ParaViewサーバ・ライブラリによって、クライアントアプ
リケーションはParaViewが並列に実行されているか否か、またどのように並列実行
されているか、といったことに関する問題の多くから解放されます。Visualization

Toolkit (VTK) は、基本的な可視化およびレンダリング・アルゴリズムを提供し
ます。VTKにはレンダリング、並列処理、ファイル入出力、並列レンダリングのよ
うな基本的な機能を提供するライブラリも含まれます。このチュートリアルでは、
ParaViewに付属するクライアントアプリケーションを使用してParaViewの使い方
を説明しますが、ParaView自体は、その高度に部品化された設計によって、大幅な
柔軟性およびカスタマイズの可能性を有しています。

1.1 開発および資金提供
ParaViewのプロジェクトは、Kitware Inc.とロスアラモス国立研究所の共同努力
によって開始されました。初期の資金は、米エネルギー省 ASCI Views計画との 3

年契約によって提供されました。最初の公開リリースであるParaView 0.6は、2002

年 10月にアナウンスされました。ParaViewの開発は、Kitware Inc.とサンディア
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国立研究所、ロスアラモス国立研究所、陸軍研究所、およびその他多くの学術・政
府機関との共同作業によって継続されました。

2005年 9月には、Kitware、サンディア国立研究所、およびCSimSoftはParaView

3.0の開発を開始しました。この開発においては、ユーザインターフェイスをさらに
ユーザフレンドリに書き直し、定量解析のためのフレームワークを開発することに
注力しました。ParaView3.0は 2007年 5月にリリースされました。

ParaViewの開発は、今日も続いています。サンディア国立研究所は、ASC計画を通
じ、ParaViewの開発への資金提供を続けています。ParaViewは、SciDAC Institute

for Ultra-Scale Visualization (www.ultravis.org)の主要な開発プラットフォームとし
て統合されています。米エネルギー省は、ロスアラモス国立研究所、陸軍の中小企
業技術革新制度、およびERDCとの契約を通じてParaViewに資金提供しています。
米国立科学財団もまた、中小企業技術革新制度によってParaViewに資金提供してい
ます。フランス電力公社、Mirarco、石油関連企業など、その他の機関も ParaView

への支援を行っています。さらに、ParaViewはオープンソースプロジェクトである
ため、スイス国立スーパーコンピューティングセンターのような機関も開発成果を
コントリビュートしています。

1.2 可視化の基礎

簡単に言うと、可視化の過程とは、生のデータを人間が見て理解することができ
る形式に変換することです。このことによって、データをより感覚的に理解するこ
とができるようになります。科学的な可視化では特に、2次元あるいは 3次元空間
において明確な表現を有するデータを取扱います。シミュレーションのメッシュや
スキャナのデータに由来するデータは、この種の分析に特に向いています。
データの可視化には、大別して 3つの段階があります。すなわち、読込み、フィル
タリング、レンダリングです。まず、データを ParaViewに読み込みます。つぎに、
データから特徴を生成、抽出、導出するためにデータを処理するフィルタを、必要
なだけ適用します。最後に、可視化された画像がデータからレンダリングされます。

ParaViewは空間的な表現としてデータを取扱うため、ParaViewが使用する基本
的なデータ型はメッシュ (または格子) です。

http://www.ultravis.org
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一様直線格子 (画像データ)

等間隔直線格子は 1、2、または 3次元の配列デー
タです。格子点は互いに直交し、各方向に等間隔に
配置されます。

非一様直線格子 (直線格子)

等間隔直線格子と似ていますが、格子点間の距離
を各軸方向に変化させることができます。

曲線格子 (構造格子)

曲線構造格子は、直線格子と同じトポロジを有し
ます。ただし、曲線格子上の格子点は (セルどうし
が重なったり、自分自身と交差しない限り) 任意の
座標に置くことができます。曲線格子は直線格子の
比較的少ないメモリ使用量、暗黙のトポロジといっ
た特徴を継承しつつ、メッシュの形状に大幅な自由
度を与えることができます。

ポリゴン・データ (ポリ・データ)

ポリゴン・データセットは、点、直線、2次元の任
意多角形から構成されます。セル間の結合は任意で
あり、結合しないこともできます。
レンダリングにおける基本的なプリミティブは、ポ
リゴン・データによって表されます。全てのデータ
は、(ボリュームレンダリングを除いて) レンダリ
ングの前に必ずポリゴン・データに変換されます
が、この変換はParaViewによって自動的に行われ
ます。
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非構造格子
非構造格子データセットは、点、直線、2次元の任
意多角形、3次元 4面体、非線形セルから構成され
ます。ポリゴン・データと類似していますが、直接
レンダリングできないような、3次元の 4面体や非
線形セルも表現することができます。

これらの基本的なデータ型に加えて、ParaViewはマルチブロックデータもサポー
トしています。データセットがグループ化されたときや複数のブロックから成るファ
イルが読み込まれた時には、必ずマルチブロックのデータセットが生成されます。Par-

aViewはさらに、階層化適応メッシュ分割(AMR)、階層化一様AMR、八分木デー
タセットを表現するためのデータ型を有します。

1.3 さらなる情報
様々なところから、ParaViewに関するさらなる情報を入手することができます。
初心者には、ParaViewアプリケーションの ボタンをクリックすることでアクセ
ス可能な、オンライン・ヘルプがあります。このオンライン・ヘルプに加え、Amy

Henderson Squillacoteによって書かれ、Kitwareから入手可能なThe ParaView Guide

は、ParaViewの全てに関するガイドとして役立ちます。
ParaViewのウエブページwww.paraview.orgもまた、ParaViewに関するさらなる
情報を入手する絶好のサイトです。このサイトから、メーリングリスト、Wiki、よ
くある質問集、さらには有償サポートサービスへのリンクを辿ることができます。

http://www.paraview.org
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それでは、ParaViewを使ってみましょう。ここから先の内容を進めるには、自身で
ParaViewをインストールして頂く必要があります。とりわけ、この文書はParaView

のバージョン 3.6 に基づいています。既にParaViewのバージョン 3.6 をお持ちでな
ければ、www.paraview.orgからダウンロードできます (ダウンロードへのリンクを
クリックして下さい)。ParaViewは、大抵のアプリケーションと同じようにして起
動します。Windowsでは、スタート・メニューから起動します。Macintoshでは、イ
ンストールしたアプリケーションバンドルを開いて下さい。Linuxでは、コマンドプ
ロンプトから paraviewを実行して下さい (パスが設定されている必要があります)。
このチュートリアルの例では、http://www.paraview.org/Wiki/ParaView Tutorial

から入手可能なデータを使用します。このデータを、簡単にアクセスできる適当な
ディレクトリにインストールして下さい。このチュートリアルによってファイルを
読み込むよう指示された時は、このデータをインストールしたディレクトリから読
み込んで下さい。

2.1 ユーザインターフェイス

ParaViewのGUIは、実行されているプラットフォームにおける形式 (ルック・ア
ンド・フィール) に従いますが、基本的には全てのプラットフォームで同じように
操作します。ここに示したレイアウトは、ParaViewが最初に起動された時のデフォ
ルトのレイアウトです。GUIは以下の要素から構成されます。

http://www.paraview.org
http://www.paraview.org/Wiki/ParaView_Tutorial


8 第 2 章 基本的な使用法

メニューバー 他のプログラムと同様に、メニューバーから大部分の機能を利用する
ことが可能です。

ツールバー ツールバーによって、ParaViewの中でも最も一般的に使用される機能
を素早く利用することができます。

Pipeline Browser (パイプライン・ブラウザ) ParaViewは、パイプラインによっ
てデータの読み込みとフィルタリングを管理します。パイプライン・ブラウザ
によって、パイプラインの構造を表示し、パイプライン・オブジェクトを選択
することができます。ParaView 3のための再設計によって、パイプライン・ブ
ラウザは、パイプライン構造をインデントして表現する便利なリストとなりま
した。

Object Inspector (オブジェクト・インスペクタ) オブジェクト・インスペクタで
は、現在選択されているパイプライン・オブジェクトの設定を表示および変更
することができます。オブジェクト・インスペクタには、3つのタブがあります。
Properties (プロパティ) タブには、オブジェクトの状態に関して設定可能な
オプションが提示されます。Display (ディスプレイ)タブには、ビュー画面で
のオブジェクトの表現方法に関するオプションが提示されます。Information

(情報) タブには、パイプライン・オブジェクトによって生成されたデータに関
する基本的統計情報が表示されます。

3D View (3Dビュー) GUIの残りの部分はデータの提示に使用され、ここでデー
タを表示・操作・分析することができます。この部分は、データの幾何的表現
を提示する 3D Viewで初期化されます。

ここで留意すべきは、GUIのレイアウトは大幅に設定変更が可能であり、そのた
めウインドウの見た目の変更が容易であることです。ツールバーは各所に移動し、
あるいは隠すこともできます。ツールバーの表示を変更するには、View → Toolbars

メニューを使用して下さい。パイプライン・ブラウザとオブジェクト・インスペク
タは、いずれもドック可能なウインドウです。すなわち、これらの要素はGUIの中
を各所に移動したり、フローティング・ウインドウとして切離したり、完全に隠す
ことができます。これらの 2つのウインドウは ParaViewの操作に重要なので、こ
れらを隠した後に再度必要となった場合は、Viewメニューから表示することができ
ます。

2.2 ソース
ParaViewにデータを入力するには、2とおりの方法があります。すなわち、デー
タをファイルから読み込むか、またはソースオブジェクトによって生成する方法で
す。全てのソースは Sourcesメニューにあります。ソースによって例えば、ビューに
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注記を追加することもできますし、ParaViewの機能を (実際に動作させながら) 調
べたい時にも非常に便利です。

演習 2.1: ソースの作成
簡単な例から始めましょう。Sourcesメニューから、Cylinder (シリンダ) を選択して
下さい。そうすると、パイプライン・ブラウザに Cylinder1という項目が追加され、
選択された状態となります。さらに、オブジェクト・インスペクタには、シリンダ・
ソースのプロパティが表示されています。ここではデフォルトの設定で良いので、そ
のまま Apply ボタン をクリックして下さい。

Applyをクリックすると、シリンダ・オブジェクトが右側の 3Dビュー・ウインド
ウに表示されます。この 3Dビューは、3Dビュー上でマウスをドラッグすることで、
視点を操作することができます。マウスのそれぞれのボタン (左、中、右) を押しな
がらドラッグすることで、回転、平行移動、ズームの操作を行えます。また、シフ
トやCtrlキーなどの修飾キーを押しながら、同様の操作を行ってみて下さい。

ParaViewによって作成されるシリンダ・オブジェクトは真の円筒ではなく、多角
形小面による円筒の近似であることにお気づきと思います。シリンダ・ソースのデ
フォルト設定では、わずか 6小面からなる非常に粗い近似が生成されます。(実際の
ところ、このオブジェクトは円筒というより多角柱に近く見えます。) より円筒ら
しい表現が必要であれば、Resolution設定の値を増やすことで、円筒に近い形にす
ることができます。

スライダもしくはテキスト入力フィールドを使用して、分割数を 50、またはそれ
以上にして下さい。ここで、Applyボタン が再び緑色 (Macでは青色)になっ
たことに留意して下さい。これは、オブジェクト・インスペクタに対して行った変
更が即座には適用されないためです。ハイライト状態のボタンは、パイプライン・
オブジェクトのいずれかの設定が、現在表示されているものから変更されているこ
とを示しています。Applyボタンをクリックするとこれらの変更が適用され、Reset

ボタン をクリックすると、全ての設定が最後に適用が行われた時の状態に
戻ります。ここでは、Applyボタンをクリックして下さい。真の円筒とほとんど見分
けがつかない程、分割数が変わる筈です。 �

ここで、ツールバーの取消し および再実行 ボタンを紹介します。データ
の可視化は多くの場合、試行錯誤の過程であり、一つ前の状態に戻れることが有用
な状況があります。実際、データを作成する前の時点にまで取消しで戻って、再実
行を行うことができます。

演習 2.2: 取消しおよび再実行
取消し ボタンと再実行 ボタンを試してみて下さい。もしその為の準備が整っ
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ていないのなら、演習 2.1で行ったように、パイプライン・オブジェクトを作成およ
び変更して下さい。設定の変更が取消されたり、再び適用される様子を見てくださ
い。同様に、パイプライン・オブジェクトの全体が消去されたり、再度作成された
りする様子も見て下さい。
さらに特別なボタンとして、カメラ操作の取消し 、カメラ操作の再実行 ボ
タンがあります。これらによって、今までに試行したカメラのアングルを行ったり
来たりすることができ、マウス操作の誤りによって完璧なカメラアングルが崩れる
ことを心配する必要がなくなります。カメラを様々に動かして、これらのボタンで
カメラ操作を取消したり、再実行してみて下さい。 �

オブジェクトがどのようにレンダリングされるかを選択するための設定も、多数
あります。3Dビューの上には ボタンがあり、レンダリングの設定を変更するこ
とができます。これをクリックするとダイアログボックスが開き、背景色、ライティ
ング、注釈などを変更することができます。

レンダリング設定のためのもう一つの操作パネルは、オブジェクト・インスペク
タのDisplayタブです。このタブのレンダリング設定は、選択されたオブジェクトに
限って適用されるものです。例えば表示・非表示の切替え、表示色、データセット
の表現方法などを設定できます。利便性のため、これらのビュー設定の幾つかとオ
ブジェクトの表示設定は、ParaViewのGUI上の他の場所 (ツールバーなど) にも存
在します。
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演習 2.3: レンダリング設定の変更
3Dビューの上の ボタンをクリックして、Render View Optionsダイアログ・ボッ
クスを表示させて下さい。設定画面のそれぞれのパネルを試してみて下さい。以下
のようにして、ビューの見え方を変更してみて下さい。(ApplyもしくはOKをクリッ
クして、変更を適用することを忘れないでください。)

• 背景色を変更して下さい。(デフォルトの色にリセットすることもできます。)

• 方向表示座標軸 (ビューの左下隅の座標軸) の表示の有無を切替えて下さい。

• ビュー内の方向表示座標軸を移動させてみましょう。(ヒント: 座標軸をイン
タラクティブな状態に設定し、3Dビュー内で座標軸をクリックやドラッグし
て下さい。)

つぎに、円筒の描画設定を変更してみましょう。(シリンダなどのパイプライン・
オブジェクトをまだ作成していなければ、演習 2.1で行ったようにして作成して下
さい。) パイプライン・ブラウザ上で円筒が選択されていることを確認して下さい。
オブジェクト・インスペクタでは、Displayタブを選択して下さい。

• 円筒の色 (Solid Color) を設定して下さい。(注: ツールバーの ボタンでも、
色を設定することができます。)

• 円筒に光沢感を追加して下さい。(ヒント: Specular Intensityを 1.0にして下
さい。)

• 円筒を透明にして下さい。(ヒント: Opacityの値を下げてください。)

• 目盛りのついた 3D座標軸を表示させ、空間的な位置がわかるようにしてくだ
さい (Show cube axes)。

シリンダ・ソースについては以上です。オブジェクト・インスペクタの Properties

タブを選択し、削除 をクリックすることで、パイプライン・オブジェクト
を削除できます。 �

2.3 データの読込み
ParaViewのGUIはいくらか練習しましたので、実際のデータを読込んでみましょ
う。ご想像のとおり、Fileメニューの最初の項目にOpenコマンドがあり、さらにツー
ルバーにもファイルを開くためのボタン があります。ParaViewは多くのファイ
ル形式をサポートし、ファイル形式のリストは新たな形式が追加される度に長くなっ
ています。以下は、現在読込みが可能なファイル形式です。
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• ParaView Data (.pvd)

• VTK (.vtp, .vtu, .vti, .vts, .vtr)

• VTK Multi Block (.vtm, .vtmb,

.vtmg, .vthd, .vthb)

• Partitioned VTK (.pvtu, .pvti,

.pvts, .pvtr)

• VTK Legacy (.vtk)

• Exodus

• XDMF (.xmf, .xdmf)

• LS-DYNA

• SpyPlot CTH

• EnSight (.case, .sos)

• netCDF (.ncdf, .nc)

• BYU (.g)

• Protein Data Bank (.pdb)

• XMol Molecule

• PLOT3D

• Digital Elevation Map (.dem)

• VRML (.wrl)

• PLY Polygonal File Format

• Stereo Lithography (.stl)

• Gaussian Cube File (.cube)

• POP Ocean Files

• AVS UCD (.inp)

• Meta Image (.mhd, .mha)

• Facet Polygonal Data

• Phasta Files (.pht)

• SESAME Tables

• MFIX (.RES)

• Fluent Case Files (.cas)

• OpenFOAM Files (.foam)

• Cosmology Files (.cosmo)

• PNG Image Files

• TIFF Image Files

• Raw Image Files

• Comma Separated Values (.csv)

モジュール化された ParaViewの設計によって、新たな VTKの読込みオブジェ
クトの ParaViewへの統合が容易になっています。従って、新たなファイルフォー
マットがサポートされていないか、頻繁にチェックされることをお勧めします。も
し、お探しのファイル読込みオブジェクトが ParaViewに含まれていないようであ
れば、ParaViewメーリングリスト (paraview@paraview.org) で調べてみて下さい。
ParaViewからは見えないものの、VTKには含まれており、容易に追加できるファ
イル読込みオブジェクトも多数あります。さらには VTKフレームワークへの組み
込みが可能でありながら、VTKにはまだ組み込まれていない読み込みオブジェクト
も多数あります。誰かがあなたの必要な読込みオブジェクトをそのような形で持っ

mailto:paraview@paraview.org
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ており、快く提供してくれるかもしれません。

演習 2.4: ファイルを開く
それでは、初めてのファイルを開いてみましょう。Openツールバー (もしくはメニュー
項目) をクリックし、disk out ref.ex2を開いて下さい。ファイルを開く操作は 2

段階の操作であり、この段階では、まだ読込んだデータは見られないことに注意し
て下さい。その代わり、オブジェクト・インスペクタに、どのようにデータを読み
込むかを指定するための設定が提示されます。

Variables (変数) リストのヘッダ (最上部) にあるチェックボックスをクリックし、
全ての変数が読込まれるようにして下さい。これは小さなデータセットなので、メ
モリに読み込むデータ量が過大になることを心配する必要はありません。全ての変
数を選択したら、 をクリックして全てのデータを読込んで下さい。データ
が読込まれたら、一端に穴の開いた円筒のような形状が表示されます。このデータ
は、加熱された回転円盤周囲の気流シミュレーションの結果です。表示されている
メッシュは円盤周りの空気で、シミュレーションの領域境界が円筒形になっていま
す。真ん中の中空部分は、もしこのシミュレーションのためにこの部分もメッシン
グされていれば、加熱された円盤が存在するはずの場所です。 �

データのフィルタリングに進む前に、データの表現方法の幾つかを簡単に見てお
きましょう。データの表現に関する最も一般的な設定は、2つのツールバーに配置
されています。

演習 2.5: 表現方法とフィールド・データによる色付け
データの表現方法を幾つか試してみましょう。パイプライン・ブラウザで、disk out

ref.ex2が選択されていることを確認して下さい。(もし、まだデータを読込んでい
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なければ、演習 2.4の手順を行って下さい。) 変数選択 (上図のMapped Variable)

を使用して、表面を Pres変数で色付けしてみて下さい。次に色の凡例表示 (上図の
Toggle Color Legend) をオンにして、実際の圧力の値を見てみて下さい。メッシュ
の構造を見るには、表現方法 (上図のRepresentation) を Surface With Edgesにしま
す。Wireframe表現にすると、セル構造とメッシュの内部の両方を見ることができ
ます。

�

2.4 フィルタ
これまでのところ、とりあえずはデータの読込みに成功し、そのデータの情報を
幾らか見ることができました。つまり、メッシュの基本的な構造を表示し、メッシュ
の表面に何らかのデータをマッピングできるようになりました。しかしながら、こ
れから見るように、データの表面をただ眺めるだけでは判らない興味深い特徴が、
このデータには多数あります。(スカラーやベクトルのような) 異なった型の多くの
変数が、このメッシュには関連づけられています。さらに、メッシュはソリッド (中
実) なモデルであることに注意して下さい。興味深い情報の多くは、内部に存在し
ています。
フィルタを適用することで、データに関してさらに多くのことを発見できます。
フィルタとは、データから特徴を生成、抽出、または導出するためにデータを処理
する機能ユニットです。フィルタは読込みオブジェクト、ソース、あるいは他のフィ
ルタに接続され、それらのデータに対し何らかの形で変更を加えます。これらの互
いに接続されたフィルタによって、可視化パイプラインが形成されます。ParaView

では、非常に多数のフィルタが利用可能です。以下は対応するフィルタ・ツールバー
上のアイコンをクリックすることで利用できる、最も一般的なフィルタです。
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Calculator (電卓) 格子点またはセル毎に、ユーザによって定義された数式を
評価します。

Contour (コンター) スカラー場がユーザによって指定された値に等しくなる
ような点、曲線、面を抽出します。この面は等値面とも呼ばれます。

Clip (クリップ) 形状を半空間で切断します。その結果、ユーザによって定義
された面のいずれか一方の側の形状が削除されます。

Slice (スライス) 形状を面で切断します。その結果はクリップと同様ですが、面
上の形状だけが残されます。

Threshold (しきい値) スカラー場の指定された範囲に存在するセルを抽出し
ます。

Extract Subset (サブセットの抽出) 抽出すべきボリュームあるいは間引き率
を指定し、格子のサブセットを抽出します。

Glyph (グリフ) グリフ、すなわち単純な形状をメッシュの各格子点に配置し
ます。グリフはベクトルによって方向を指定し、ベクトルまたはスカラーに
よってスケーリングすることができます。

Stream Tracer (流線追跡) ベクトル場にシード点を配置し、(定常の)ベクト
ル場をそれらのシード点から追跡します。

Warp (vector) (ワープ (ベクトル)) メッシュの各格子点を、与えられたベク
トル場で変形させます。

Group Datasets (データセットのグループ化) 複数のパイプライン・オブジェ
クトの出力を、一つのマルチブロック・データセットに統合します。

Extract Group (グループの抽出) マルチブロック・データセットを構成する
要素 (ブロック) を抽出します。

これらの 11種のフィルタは、ParaViewで利用可
能なもののごく一部の例です。Filtersメニューには、
データ処理のためのフィルタがさらに多数存在しま
す。ParaViewからは現在のところ 80以上のフィルタ
が利用可能であるため、簡単にフィルタを見つけられ
るよう、Filtersメニューは以下のようにサブメニュー
に整理されています。

Recent (最近使ったフィルタ) 最も最近使われたものが一番上に来るようソートさ
れた、最も最近使われたフィルタのリストです。
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Common (一般的) 最も一般的なフィルタです。これはフィルタ・ツールバーにリ
ストされているフィルタと同じで、前述のとおりです。

Data Analysis (データ分析) 定量的な値をデータから取り出すためのフィルタで
す。これらのフィルタはメッシュ上でデータを計算したり、メッシュから要素
を抽出したり、データをプロットするのに使用します。

Temporal (時間依存型) 時間によって変化するデータを分析、あるいは加工する
フィルタです。全てのフィルタは各時刻のスナップショットに対して実行され
るため、時間によって変化するデータに対して使用可能です。しかしながらこ
の分類のフィルタは特に、利用可能な時間範囲を走査し、データが時間ととも
にどのように変化しているかを調べることができます。

Alphabetical (アルファベット順) 全ての利用可能なフィルタのアルファベット順
のリストです。あるフィルタがどこにあるか判らなければ、このリストには確
実に存在します。また、このリストにしか存在しないフィルタも多数存在し
ます。

これらのフィルタの一覧、特にアルファベッ
ト順の全フィルタのリストはあまりに多く、目
的のフィルタを探すのは面倒です。フィルタを
素早く選ぶには、クイック起動ダイアログを
使用して下さい。Windowsおよび Linuxでは
Ctrlキーと Spaceキー、MacintoshではAltと
Spaceキーを同時に押すと、ここで示すような
小さなダイアログボックスが現れます。フィル
タ名に含まれる単語、またはその一部を入力
すると、その入力した語を含むソースとフィル
タが一覧表示されます。目的のフィルタまたはソースを選択し、Enterキーを押す
と、それがパイプライン・ブラウザに追加されます。
フィルタの一部はメニュー上でグレーになっていて、選択できないことにお気づ
きかと思います。多くのフィルタは特定の型のデータにしか適用できないため、常
に使用できる訳ではありません。ParaViewはそのようなフィルタをメニューおよび
ツールバーから選択不可にし、それらのフィルタが使用不可であることを示し (ま
た、それを強制し) ます。
このチュートリアルでは多くのフィルタを使用しますが、それでも全てを試せる
訳ではありません。それぞれのフィルタのさらなる情報については、The ParaView

Guideをご覧下さい。

演習 2.6: フィルタを適用する
それでは最初のフィルタを適用しましょう。disk out ref.ex2がまだ読込まれていな
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ければ、ここで読込んで下さい (演習 2.4)。パイプライン・ブラウザ上で disk out

ref.ex2が選択されていることを確認し、フィルタ・ツールバーまたはFiltersメニュー
から、Contour フィルタを選択して下さい。パイプライン・ブラウザの読込みオ
ブジェクトの下に新たな項目が追加され、オブジェクト・インスペクタにフィルタ
の設定画面が表示されます。ファイルの読込みと同様に、フィルタの適用も 2段階
の操作です。フィルタの作成後、フィルタの適用前に設定を変更することができま
す (そしてそれはほぼ大抵の場合、必要な操作です)。

コンター・フィルタを使って、温度が 400 Kの等値面を作成することにしましょ
う。まず、Contour Byの設定をTemp変数に変更します。つぎに、等値面の値を 400

に変更します。最後に、 をクリックしてください。等値面がボリュームの
内部に現れる筈です。もし disk out ref.ex2が演習 2.5のとおりに圧力で色付けされ
たままであったら、等値面も同様に圧力で色付けされます。

�

以上の演習では、フィルタを使ってデータを加工し、必要な結果を得る方法を学
んで来ました。ほとんどの一般的な処理では、単一のフィルタで必要な情報を得る
ことができます。しかしながら、フィルタは読込みオブジェクトと同種のオブジェク
トです。すなわち、読込みオブジェクトに対して適用するような操作を、フィルタ
に対しても適用することができます。それはつまり、あるフィルタによって生成さ
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れたデータに対して、さらにフィルタを適用することができるということです。こ
れらの一連の互いに接続された読込みオブジェクトとフィルタを、可視化パイプラ
インと呼びます。この可視化パイプラインを形成する機能は、要求に合わせてデー
タの可視化を行うための強力な仕組みです。
もう少し、フィルタを色々試してみましょう。内部にあるものの表示をしばしば
妨げるメッシュ表面のワイヤフレーム表示の代わりに、表面の一部を切り取った状
態にしましょう。この操作には 2つのフィルタが必要です。すなわち、1つ目のフィ
ルタで表面を抽出し、2つ目で表面の一部を切り取ります。

演習 2.7: 可視化パイプラインの作成
この演習の画像および議論のいくつかは、演習 2.6を終えた直後の状態からこの演
習を始めることを前提としています。もし ParaViewを再起動していたり、その他
の理由で異なる状態にある場合は、たんに disk out ref.ex2を読込めば充分です。
それでは表面を抽出するフィルタを追加しましょう。それは以下の手順で行います。

1. パイプライン・ブラウザで disk out ref.ex2を選択します。

2. メニューバーから Filters → Alphabetical → Extract Surfaceを選択します。 も
しくはクイック起動 (Windows/LinuxではCtrl+Space、MacではAlt+Space)

を呼び出して、extract surfaceと入力し、そのフィルタを選択して下さい。

3. ボタンをクリックしてください。

Extract Surfaceフィルタを適用すると、再びメッシュの表面が見えるようになり
ます。元のメッシュと同じように見えますが、元のデータが中実なのに対し、この
データは中空である点で異なっています。
コンター・フィルタの結果を表示させていた場合は、コンターが見えなくなりまし
たが、心配する必要はありません。表面に隠されているだけで、依然としてそこに
存在しているからです。もしフィルタの適用後の表示に何も変化が無ければ、1番目
の disk out ref.ex2を選択する操作を忘れて、違うオブジェクトにフィルタを適用し
てしまった可能性があります。もし ExtractSurface1オブジェクトが disk out ref.ex2
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に直接接続されていなければ、それが間違えた操作です。もしそのとおりであれば、
フィルタを削除して再度適用を試みてください。
それでは表面を切り取って、(もし存在すれば) 内部の構造と等値面が見えるよう
にしましょう。

4. パイプライン・ブラウザ上で、ExtractSurface1が選択されていることを確認し
ます。

5. ツールバーもしくは Filtersメニューから、クリップ・フィルター を選択し
てください。

6. オブジェクト・インスペクタの Show Planeチェックボックス か
ら、チェックを外してください。

7. ボタンをクリックしてください。

もしコンターを作成していたのであれば、メッシュ表面を切り取った内側から、等
値面コンターが見える筈です。コンターがはっきり見えるためには、メッシュを回
転させる必要があるかもしれません。 �

パイプラインにフィルタが幾つか追加されましたので、パイプライン・ブラウザ
でのこれらのフィルタの配置を見てみましょう。パイプライン・ブラウザによって、
今までに作成されたパイプライン・オブジェクトは判りやすいリストとなっており、
また、パイプライン・オブジェクトを選択し、それらのオブジェクトの隣にある目
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のアイコン をクリックすることで表示・非表示を簡単に変更できるようになっ
ています。しかしさらに、このリスト中の項目のインデントと、インデントを辿っ
て右側へ折れ曲がった線にも注目して下さい。これらの機能はパイプラインの連結
状態を示しています。これは右の図の従来型のグラフと同じ情報を、ずっとコンパ
クトなスペースに表しています。パイプライン・オブジェクトの従来型配置の問題
点は、多くのスペースが必要であり、さほど大規模でないパイプラインでさえ完全
に見渡すにはGUIの大部分が必要なことでした。しかし、このパイプライン・ブラ
ウザは、完全でありながらコンパクトです。

2.5 複数ビューの利用
科学上の目的で時折、1つの変数に絞って検討することがあります。しかし、多く
の重要な物理現象は、互いに何らかの影響を与え合う複数の変数で記述されます。そ
れゆえ、1つの視点で多くの変数を表示するのは大変難しいといえます。ParaView

はデータを多様な視点で表示し、それらを相互に関連付ける機能を持っており、そ
のような機能は複雑な可視化データを考察する上で有用です。
今までのところ、可視化では 2つの変数に注目しています。すなわち、圧力を色
のグラデーションで表し、温度による等値面を抽出して表示しています。一見、2つ
の変数をきれいに配置できているようにも見えますが、それらを分かりやすく関連
付けることはできていません。複数の視点を使うことで、両者の関係を分かりやす
くすることができます。各視点がデータの個別な特徴を表示し、さらにそれらを組
み合わせることで、より理解しやすい可視化を提示することができます。
各ビューの上部には小さなツールバーがあり、このツールバーの右側にビューを作
成したり、削除するためのボタンがあります。全部で 4つのボタンがあります。
もしくは ボタンを押すことで、既に有るビューをそれぞれ水平もしくは垂直に
分割して新たなビューを作成することができます。 ボタンはビューを削除し、そ
のビューによって占められていたスペースは隣接するビューで占められます。 ボ
タンによって、選択したビューを一時的にビュー画面いっぱいに拡大して表示する
ことができ、 で元の状態に戻ります。

演習 2.8: 複数ビューの利用
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewを
リセットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。
このボダンが何を行う物なのかは 3章でさらに詳しく解説しますが、今のところは
ParaViewを再起動するのと概ね同等であると理解しておいて下さい。
まず最初に、1つの変数に着目します。メッシュの中にある変数を見たいので、メッ
シュを半分にクリップしましょう。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックして
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ください (演習 2.4を参照して下さい)。

2. disk out ref.ex2にクリップ・フィルタ を適用してください。

3. オブジェクト・インスペクタの Show Planeのチェックボックス
からチェックを外して下さい。

4. ボタンをクリックしてください。

5. (ツールバーの) 変数選択を、Solid Colorから圧力 Presに変更し、表面を色付
けします。

メッシュ内部の平面の圧力分布が見えるようになりました。ここでさらに、同じ
平面の温度分布と比較したいとします。そのためには、新しいビューを作成するこ
とで、もうひとつの可視化を行うことができます。

6. ボタンをクリックしてください。

現在の画面は半分に分割され、右側には何も表示されていません。この何も表示
されていない部分に、新しく可視化を表示します。右の画面には、周囲に青い境界
線が表示されていることに注目してください。これはアクティブなビューであるこ
とを示しています。パイプライン・ブラウザやオブジェクト・インスペクタなどの、
あるビューの情報を表示したり、各種設定を制御するウイジェットは、アクティブ
なビューについてそれらを行います。この新しいビューには、メッシュの温度分布
を表示させます。

1. 青い境界線が、(右側の) 新しい空白のビューの周囲に表示されている状態に
してください。どのビューでもクリックすることで、アクティブなビューにす
ることができます。

2. パイプライン・ブラウザの Clip1の隣にある目のアイコン をクリックし
て、クリップしたデータの表示をオンにしてください。



22 第 2 章 基本的な使用法

3. パイプライン・ブラウザ上で Clip1を選択し、(ツールバー内の) 変数選択で変
数を Solid Colorから Tempに変更し、表面を温度分布で色付けしてください
(この時点で、色の凡例の表示をオンにしても良いです)。

画面に 2つのビューができました。1つは圧力の情報を、もう 1つは温度の情報
を表示しています。これらを比較したいところですが、2つの画面の視点方向が違
うために困難です。どのようにして、一方の視点位置をもう一方の始点位置と連動
させることができるでしょうか？この問題を解決するには、カメラのリンクを使い
ます。カメラのリンクを使うことで、2つの画面は常に同じ視点から描画されます。
カメラのリンクは簡単にできます。

4. いずれかのビューの上で右クリックし、ポップアップメニューからLink Camera...

を選択してください。(もしMacを利用していてマウスに右ボタンがない場合、
Tools → Add Camera Link...のメニューオプションを選択することで同様の操
作が可能です。)

5. もう一方の画面をクリックしてください。

6. それぞれの画面でカメラを動かしてみて下さい。

やった！2つのカメラがリンクされました。どちらのカメラも、もう一方を追随し
て動きます。カメラがリンクされると、2つの画面を比較して見ることができます。
ボタンをクリックして、視点を断面をまっすぐに見る位置にしてください。
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空気温度が、熱せられた円盤との接触面で最大となっていることがわかります。
それ自体は、驚くことではありません。空気温度が熱源近くで最大となり、離れる
に従って低くなっていくことは予想されます。しかし、同じ地点で圧力が最大では
ないことに注目してください。空気の圧力は、円盤の上空で最大値を取っています。
この情報を基に、この物理的現象にいくつかの興味深い仮説を立てることができま
す。空気の圧力分布には、2つの力が関係していることが考えられます。1つ目の力
は重力による力で、上方の空気が下方の空気を押さえつける働きをします。2つ目
の力は浮力で、熱せられた空気が密度が小さくなることで上方に昇ろうとする力で
す。空気の圧力が最大値を取る位置から、これらの 2つの力が釣り合う点が判りま
す。このような考察は、温度と圧力の両方を同時に見なければできないでしょう。�

もちろんParaViewの複数視点の機能は、同時に 2つ以上の視点も表示できます。
各々のビューには 1セットずつ、複数視点の為の分割ボタンがあります。ビュー分
割ボタン を使うことでさらにビューを作成し、ワークスペースを分割するこ
とができます。そして分割したビューは、 ボタンでいつでも削除することができ
ます。
各ビューの表示位置も固定ではありません。ビューのツールバー上 (ボタンでな
い部分)をクリックし、マウスのボタンを押したまま別のビューの上にドラッグする
ことで、2つのビューの表示位置を入れ替えることができます。この操作によって、
2つのビューは即座に入れ替わります。

2つのビューの間をクリックし、マウスのボタンを押したままどちらか一方のビュー
の方向にドラッグすることで、ビューのサイズを変更することもできます。ビューの
境界はマウスの動きに従って動き、ビューの大きさもそれに合わせて調整されます。
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2.6 ベクトルの表示
このシミュレーション結果から、他にどのような結論を導けるでしょうか。シミュ
レーションは、熱せられた回転円盤上の空気の流れを表す速度場も算出しています。
ParaViewを使って、空気の流れを確認します。
ベクトル場を描画するための一般的で効率的な方法は、流線を使用することです。
流線とは、あらゆる点でベクトル場に沿っている空間中の曲線です。流線はまた、無
重量の粒子がベクトル場で取る経路を表します (流れが定常である場合)。 流線は、
シード点を与えることで生成されます。

演習 2.9: 流線
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックして
ください (演習 2.4を参照して下さい)。

2. 流線追跡フィルタ を disk out ref.ex2に適用してください。

3. ボタンをクリックして、デフォルトの設定を適用します。

メッシュの表面が、渦巻いた線に置き換えられました。これらの線は、ボリュー
ムを通る流れを表しています。円筒の中心軸周りに、渦のような流れができている
ことに注目してください。中心や端部周辺には、垂直方向の流れもあります。
新しい形状は、元々あった形状と中心がずれています。カメラのリセット コ
マンドを使うことで、新しい形状の視点を即座に中心に移動させることができます。
このコマンドは、表示されている形状を現在のビューに収め、中心を移動させると
共に、回転の中心を表示されている形状の中心に一致させます。 �

流線の問題の 1つは、現在もそうであるように、多くの線が互いに接するように
表示され、また陰影もないため、線同士の見分けがつかないことです。線は 1 次元
で、陰影を表現するには 2次元の面を必要とするからです。流線のもう 1つの問題
は、流れの方向がわからないということです。
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次の演習では、演習 2.9で作成した流線を修正して、これらの問題を解決していき
ます。チューブ・フィルタを使うことで、流線の周りに 2次元の面を作成すること
ができます。この面によって、流線に陰影と距離感の手がかりが付加されます。更
に流線に矢印を追加することで、流れの方向を示すこともできます。

演習 2.10: 流線を見やすくする

1. クイック起動 (Windows/Linuxでは Ctrl+Space、Macでは Alt+Space)を使
用して、Tubeフィルタを適用します。1

2. ボタンをクリックしてください。

流線が鮮明に見えるようになりました。流線を横方向から眺めてみると、気流の
循環を見ることができます。空気が熱せられ上昇し、冷えると下降しています。流
線を回転させてZ軸を見下ろすようにし、熱せられた円盤がある筈の辺りを見ると、
回転する円盤との摩擦によって空気が円形に流動しているのが分かります。
もう少し、装飾を施してみましょう。流線に矢印を加えることで、流れの方向と
大きさを示すことができます。

3. パイプライン・ブラウザで StreamTracer1を選択してください。

4. StreamTracer1にグリフ・フィルタ を加えてください。

5. オブジェクト・インスペクタで、Vectorsの設定 (上から 2 番目の設定) をVに
変更してください。

6. オブジェクト・インスペクタで、Glyph Typeの設定 (上から３番目の設定) を
Coneに変更してください。

7. ボタンをクリックしてください。
1原注: ParaView 3.6では、チューブ・フィルタの名称は + Generate Tubesに変更されています。

将来的には、アルファベット順のフィルタのリストから参照しやすいように、名称は Tubeに戻され
るでしょう。
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8. 矢印をTemp変数で色付けしてください。

このようにして、流線に小さな矢印が追加されました。矢印の向きは速度の方向
を示し、大きさは速度の大きさに比例しています。この新たな情報を利用して、次
の問題に答えてみましょう。

• 空気が一番速く流れているのはどこでしょうか？円盤の近く、もしくは離れて
いるでしょうか？円盤の中央付近か、それとも周縁付近でしょうか？

• 円盤の回転の向きはどちらでしょうか？

• 円盤表面では、空気は円盤の中心に向かって流れていますか、それとも周縁部
分に向かって流れていますか？

�

2.7 プロット
ParaViewのプロット機能はデータを掘り下げ、定量的な解析を可能にします。プ
ロットは基本的にフィルタによって作成されます。プロットは通常、フィルタによっ
て作成され、プロットを作成するためのフィルタは、全てFiltersメニューの下のData

Analysisサブメニューにあります。次の演習では、空間内の線分上におけるメッシュ
の場の値をプロットするフィルタを作成してみましょう。

演習 2.11: 空間中の線分上の値をプロットする
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。

1. disk out ref.ex2ファイルを開き、変数を全て読込んで をクリックして
ください (演習 2.4を参照して下さい)。



2.7. プロット 27

2. (演習 2.8のように) disk out ref.ex2にクリップ・フィルタ を適用し、オブ
ジェクト・インスペクタの Show Planeのチェックボックス から
チェックを外し、 をクリックして下さい。これによって、値をプロッ
トするための線分が見やすく、また操作しやすくなります。

3. パイプライン・ブラウザで disk out ref.ex2をクリックし、アクティブなオブ
ジェクトにして下さい。

4. メニュー・バーから Filters → Data Analysis → Plot Over Line を選択する
か、クイック起動 (Windows/LinuxではCtrl+Space、MacではAlt+Space)を
使用して、Plot Over Lineフィルタを適用します。

アクティブなビューに、両端に球の有る線分が、表示されているデータを貫く形
で描画されます。これらの球のどちらかをマウスでドラッグすることで、3Dビュー
内を移動させることができます。画面内の球を動かすたびに、オブジェクト・イン
スペクタの項目の幾つかも変化することにも注目して下さい。目的の場所にマウス
ポインタを移動させ、pキーを押すことでも球を移動させることができます。この
場合、マウスポインタの位置に存在する面に、球を順次移動させることになります。
これがクリップ・フィルタを使用した目的で、これによってクリッピング面に端点
を置くことができます。この方法で球を移動させることができるのは、ソリッドに
レンダリングされた面に対してのみであることに気をつけてください。ボリューム・
レンダリングに対しては、この方法は使えません。
この線分と球などの表現は 3Dウィジェットと呼ばれています。なぜなら、これ
は 3次元空間内で操作されるGUIコンポーネントだからです。ParaViewには、多
くの 3Dウィジェットの例があります。特にこのライン・ウイジェットは、空間内で
線分を指定するのに使用されます。他にも、点や面を指定するためのウィジェット
があります。

5. 線分が円盤の基部からメッシュ全体の頂部へ垂直に結ばれるように、3Dウイ
ジェットを操作するか、pキーを押すか、もしくはオブジェクト・インスペク
タで数値指定をして調整してください。

6. 線分を目的の位置に配置できたら、 ボタンをクリックします。
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プロットの際に行える操作がいくつかあります。マウスの中央ボタンをクリック
した状態で上下にドラッグすると、拡大・縮小を行う事ができます。右ボタンでド
ラッグすると、ドラッグ範囲へのズームができます。左ボタンでドラッグすると、プ
ロット画面をスクロールすることができます。 コマンドを使うことで、プロッ
トの範囲が収まるようビューを再設定することもできます。 �

3Dレンダリングと同様に、プロットはビューであると考えられます。どちらも
別々の方法によってではありますが、データの表現方法を提供しています。そのた
め、3Dビューと同様の操作をプロットに対して行うことができます。オブジェクト・
インスペクタのDisplayタブを見ると、色、線のスタイル、ベクトル成分、凡例など、
この表現に関する様々な設定があることがわかります。

プロット・ビュー上端の ボタンによって、ラベル、凡例、軸の数値範囲など、
プロット全体の設定を変更するためのダイアログを呼び出すこともできます。
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他のビューと同じように、File → Save Screenshotを選ぶことで、プロットの
画像を保存することができます。さらに、プロットを報告書やその他の文書で使い
やすいように、PDFフォーマットのベクトルグラフィックスで保存することもでき
ます。他のビューと同様に、プロットを移動させることもできます。
次の演習では、こういった機能を利用して、プロットからより多くの情報を引き
出します。例えば、プロットを使って、圧力と温度の値を比較することが出来ます。

演習 2.12: 一連のプロットの表示設定
この演習は演習 2.11の続きです。この演習を始める前に、演習 2.11を完了させてお
く必要があります。

1. GUI上でプロットを移動させたい場所を選択し、分割、削除、サイズ変更、位
置の変更を使って、プロットをその場所に移動させます。

2. プロットをアクティブな状態にし、Displayタブで Tempと Pres以外の変数を
全てオフにします。

Tempと Presの変数は、異なる単位を持ちます。この 2つを同じスケールで比べ
るのは、有用ではありません。したがって、同一のプロット上で各変数を各々のス
ケールで表示し、比較することができます。ParaViewの直線プロットでは、左軸と
右軸それぞれに異なったスケールを設定することができ、各変数を別々の軸にした
がってスケールさせることができます。

3. Displayタブ上で Presを選択します。

4. Chart Axisを Bottom - Rightに変更します。

このプロットから、2.5 節で行った考察が正しいことが確認できます。温度がプ
レートの表面で最大値を取り、そこから離れるに従って下がるのに対し、圧力は少
し上昇してから下降し始めます。さらに、圧力が最大値をとるのは (そして、空気
中で力が釣り合うのは) 3単位長さだけ離れた位置であることもわかります。 �
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ParaViewは、任意の数の異なった種類のビューに対応しています。これによって
研究者や開発者は、新しい視点でデータを見ることができます。さらにもう一つの
ビューの例を示すために、パイプライン・ブラウザの disk out ref.ex2を選択し、さ
らに Filters → Data Analysis → Histogram を選択してみましょう。温度のヒスト
グラムを作成し、 ボタンをクリックします。

2.8 ボリューム・レンダリング
ParaViewには、データの表現方法がいくつかあります。サーフェス、ワイヤフレー
ム、およびそれらの組合せといった、いくつかの例を既に見てきました。ParaView

はさらに、データセット表面上の点、もしくは単純にバウンディング・ボックスを
表示することもできます。

点 ワイヤフレーム サーフェス サーフェスと
エッジ

ボリューム

ボリューム・レンダリングは、ParaView上でデータを表現する上で強力なテク
ニックです。ボリューム・レンダリングでは、中実なメッシュが、メッシュ内の各
点における色と濃度を表すスカラー場によって、半透明の雲のような塊としてレン
ダリングされます。サーフェス・レンダリングとは違い、ボリューム・レンダリン
グでは、ボリュームを通してデータセット内部の特徴に至るまで把握することがで
きます。
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ボリューム・レンダリングは、オブジェクトの表現方法を変更することで簡単に
実現できます。温度の表示をボリューム・レンダリング表示に変えてみましょう。

演習 2.13: ボリューム・レンダリングをオンにする
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。

1. disk out ref.ex2ファイルを開き、全ての変数を読み込み、 をクリック
してください (演習 2.4参照)。

2. パイプライン・ブラウザ上で、disk out ref.ex2が選択されていることを確認し
てください。表示される変数をTempに、表現方法を Volumeにそれぞれ変更
します。

不透明なメッシュの代わりに、半透明なボリュームが表示されました。画像を回
転させる際に、パフォーマンスの関係でその画像が一時的に簡単な画像に置き換え
られますが、これについての詳細は後ほど、3章に記します。 �

ParaViewのボリューム・レンダリングの優れた点は、他のオブジェクトのサー
フェス・レンダリングと同時に使用できることです。これによって対象のボリュー
ム・レンダリングの周囲の状況を再現したり、また他の表示と組み合わせることで、
より多くの情報を伝えることができます。例えば、温度のボリューム・レンダリング
を、演習 2.9で行ったような流線ベクトルの可視化と組み合わせることができます。

演習 2.14: ボリューム・レンダリングとサーフェス表現の可視化を組
合わせる
この演習は演習 2.13の続きです。この演習を始める前に、演習 2.13を完了させる必
要があります。

1. 流線追跡フィルタ を disk out ref.ex2に追加します。

2. ボタンをクリックして、デフォルトの設定を適用します。
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これで、ボリューム・レンダリングの中に、流線が埋め込まれているのが見える
筈です。以下の追加の操作によって、演習 2.10でのように、流線に形状を追加して、
流線を見やすくすることができます。これらは必須ではありませんので、省略する
こともできます。

3. クイック起動 (Windows/Linuxでは Ctrl+Space、Macでは Alt+Space)を使
用して、Tubeフィルタを適用し、 をクリックします。

4. 流線がTempで色付けされていれば、Solid Colorに変更します。

5. パイプライン・ブラウザで、StreamTracer1を選択します。

6. グリフ・フィルタ を StreamTracer1に追加します。

7. オブジェクト・インスペクタで、Vectorsの設定 (上から 2つ目の設定) をVに
変更します。

8. オブジェクト・インスペクタで、Glyph Typeの設定 (上から 3つ目の設定) を
Coneに変更します。

9. ボタンをクリックします。

10. Temp変数によってグリフを色付けします。

これで、流線がボリューム全体に渡って温度場の中に表示されました。 �

デフォルトでは、ParaViewはサーフェス・レンダリングで使われているのと同じ
色を、値の範囲の最低値を不透明度 0、最高値を不透明度 1に設定して描画します。
ParaViewでは伝達関数 (スカラー変数を表示する際の色や不透明度に関する設定)

の変更も簡単に行えます。パイプライン・ブラウザ上でボリューム・レンダリングさ
れたオブジェクトを選択した状態で、カラーマッピングの編集 ボタンをクリッ
クしてください。
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それによって現れるダイアログでは、伝達関数に関する設定を編集することがで
きます。ダイアログ上部のグラデーションになったボックスは、色で伝達関数を、黒
色の線プロットで不透明度を表しています。伝達関数上の丸い点は、制御点を表して
います。制御点とは特定のスカラー値に設定された色と不透明度のことであり、制
御点間の色と不透明度は補間値が与えられます。バー上の空白部分をクリックする
と、新しい制御点が作成されます。既に有る制御点上でクリックすると、その点を
選択します。選択された制御点は、ボックスの中をドラッグしてスカラー値と透明
度を変更でき、選択された制御点上でもう 1度クリックすることで新しくダイアロ
グボックスが表示されます。選択された制御点は、BackspaceキーもしくはDelete

キーを押すと削除されます。
カラーバー直下には、テキスト入力ウィジェットがあり、選択された制御点のScalar

Value (スカラー値) と Opacity (不透明度) の数値を指定できます。Scaleの設定は、
不透明度の計算における単位長を調節します。数字が大きいほど、ボリュームが透
明になります。Color Spaceの設定では、色の補間方法を変更できます。このパラ
メータは制御点の色には影響しませんが、制御点間の色には大きく影響します。Use

Logarithmic Scaleチェックボックスによって、色のスケールを対数尺度に変換するこ
ともできます。
伝達関数の設定は面倒になりがちですので、 ボタンをクリックするこ
とで設定を保存することができます。 ボタンによって現れるダイアログで
は、作成したカラー・マップや、ParaViewに最初から用意されているカラー・マッ
プを、管理および適用することができます。

演習 2.15: ボリューム・レンダリングの伝達関数を変更する
この演習は、演習 2.14の続きです。この演習を始めるには、演習 2.14 (または、少
なくとも演習 2.13) を完了させておく必要があります。

1. パイプライン・ブラウザの disk out ref.ex2をクリックし、アクティブにします。

2. カラー・マップの編集ボタン をクリックします。
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3. 制御点を追加・変更し、それらのボリューム・レンダリングへの影響を観察し
てください。

4. ボリューム・レンダリングを、さらに熱の表現にふさわしくします。
をクリックし、ダイアログ・ボックスからBlack-Body Radiationを選択し、OK

をクリックします。

ボリューム・レンダリングのカラー・マッピングのみならず、全てのビューでの
Tempのカラー・マッピングが変更されていることに注意してください。これによっ
てビュー同士の一貫性を保証し、同じ変数を違う色や違う値の範囲でマッピングし
てしまうことによる混乱を避けることができます。 �

2.9 時間
ここまで disk out refのシミュレーションを余すところなく分析して来ましたの
で、次は新しいシミュレーションに進んで、ParaViewがどのように時間を扱ってい
るのかを見てみましょう。この節では、簡単なシミュレーションによる、時間によ
る変化のある新たなデータセットを使用します。

演習 2.16: 時間情報を持つデータを読み込む
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。

1. Openメニューから、can.ex2を開きます。
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2. 先程と同じように、変数リストの最上部のチェックボックスをクリックして、
全ての変数が読み込まれるようにし、 ボタンを押します。

3. ボタンを押して、カメラをメッシュに向けます。

4. 再生ボタン を押して、落下するレンガによって缶が潰れる様子のメッシュ
が、ParaViewによってアニメーションされる様子を見てみましょう。

�

時間変化するデータを扱う際にすることは、これだけです。ParaViewには時間の
概念が組み込まれていて、データ内の時間と自動的にリンクするようになっていま
す。時間を扱うためのツールバーに慣れてください。

アニメーションの保存も同様に簡単です。メニューから File → Save Animationを
選択します。ParaViewでは、ダイアログでどのようにアニメーションを保存するか
の設定ができ、そして自動的に時間を反復してアニメーションを保存します。

演習 2.17: 時間依存のデータの落とし穴
ユーザーが陥る最大の落とし穴は、値の範囲が時間変化する場合の色のマッピング
です。例を見るために、以下を行ってください。

1. 演習 2.16から続けているのでなければ、can.ex2を開き、全ての変数を読み込
む設定とし、 をクリックして下さい。

2. 最初の時刻ステップ に移動します。

3. EQPS変数をオンにします。

4. 色の凡例 をオンにします。

5. アニメーションを再生 (または、最後の時刻ステップ へ移動) します。
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色付けは、あまり効果を発揮していません。簡単に問題を解決するには、以下を
行います。

6. 最後の時刻ステップにいる状態で、データ範囲にスケールを調整する ボ
タンを押します。

7. もう一度、アニメーションを再生 して下さい。

これで、色付けが効果を発揮するようになりました。 �

これは一見、欠陥のように見えますが、そうではありません。これは 2つの避け
がたい要因のためです。1つ目は、スカラー場の可視化を行うと、スケール範囲はそ
の時刻ステップでのデータの値の範囲に合わせて設定されます。理想を言えば、ス
ケールの範囲は、データの全ての時間を通しての最大値と最小値に設定されるべき
です。しかしながら、それを実現しようとすると ParaViewは最初の読み込みで全
てのデータをチェックすることになり、大規模データを処理する際にひどく動作が
遅くなってしまいます。2つ目は、時間を追ってアニメーションさせる際には、例
えデータの値の範囲が変わってもスケールの範囲は固定である必要があるからです。
アニメーションの再生に合わせて表示するスケールの範囲を変更することは、デー
タを誤って解釈する原因になります。スケールの範囲が暗黙に変動するよりは、当
初設定したとおりのカラー・マッピングの範囲から逸脱する方が断然良いでしょう。
とはいえ、代表的な時刻ステップで を押すか、カラー・スケールのダイアログ
を開き 、データの範囲を指定することで、このような問題を簡単に解消すること
ができます。

2.10 選択機能
ParavView 3のリリースにおいて大いに進歩し、なお進化し続けている特徴は選
択機能です。選択はいつでも行うことができ、また ParaViewは現在選択されてい
る部分を、全てのビュー間で同期された形で保持しています。つまり、あるビュー
で何か選択すると、その選択範囲は同じオブジェクトを表示している全てのビュー
で表示されます。

ParaViewでは、一つのデータセットにおける点、セル、ブロックを選択すること
ができます。また、多種の IDリストアップ機能、空間中の位置指定、スカラー値の
指定などの様々な方法によって、選択範囲に含まれる要素を指定することができま
す。これから、それらの組み合わせのいくつかを見てみましょう。
選択部分を生成する最も簡単な方法は、要素をまさに 3Dビューの中から選び出
すことです。3Dビューにおける全ての選択操作は、ラバー・バンドという選択機能
によって行います。つまり、3Dビュー内でマウスをクリックしたりドラッグするこ
とで、箱状の範囲内の要素を選択することができます。ラバー・バンドによる選択
方法はいくつかの種類があり、選択設定のツールバーにあるアイコンのいずれかを



2.10. 選択機能 37

選ぶか、ショートカット・キーのいずれかによってそのうちの一つを選ぶことがで
きます。次の 3D選択方法が可能です。

Select Cells On (Surface) (表面上のセルを選択する) ビュー内で見えるセ
ルを選択します。(ショートカットは s)

Selects Points On (Surface) (表面上の点を選択する) 視点内で見える点を
選択します。

Select Cells Through (Frustum) (表面および内部のセルを選択する) ラ
バー・バンド内に存在する全てのセルを、対象オブジェクト内部のセルも含
めて選択します。

Select Points Through (Frustum) (表面および内部の点を選択する) ラ
バー・バンド内に存在する全ての点を、対象オブジェクト内部の点も含めて
選択します。

Select Blocks (ブロックを選択する) マルチブロック・データセットから、ブ
ロックを選択します。(ショートカットは b)

sと bのショートカットによって、それぞれセルやブロックを手早く選択できま
す。マウスカーソルを選択中の 3Dビュー上のどこかに置いてから、それらのキー
を入力しましょう。そして、選択したいセルやブロックをクリックしましょう (ある
いは複数の要素上にラバー・バンドをドラッグしましょう)。
ここで選択機能を試してみて下さい。
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選択要素はセレクション・インスペクタで管理できます。セレクション・インス
ペクタは View → Selection Inspectorで見ることができます。セレクション・インス
ペクタでは、選択されている全ての点やセルを見るほかにも、選択を修正すること
もできます。またセレクション・インスペクタを使って選択要素にラベルを付加し、
要素の特定をしやすくすることができます。
セレクション・インスペクタを少し試してみましょう。Selection Inspectorを開い
てください。そしてラバー・バンドを使って選択範囲を作成し、Selection Inspector

で結果を見てみてください。また IDを変更したり、Invert Selectionのチェックボッ
クスによって選択範囲を反転して、選択範囲を変更してみてください。
すると / の表面選択ツールは点/セルのリストを表示し、 のブロック選
択ツールはブロックのリストを表示しますが、 / の内部選択ツールはどちら
も表示していないことに気づくでしょう。これは、これらのツールが空間内の領域
を選択しているからです。選択領域を見たい場合は、Show Frustumをクリックし、
3Dビューを回転させてください。
ここで、一連の点やセルを特定する選択と、空間内の領域を特定する選択には、
根本的な違いがある事を記しておくべきでしょう。この違いを理解するには、以下
を試してください。

演習 2.18: データ要素を特定する選択と空間的な選択

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.16を参照)。

2. Select Cells Through ツールを使って、選択領域を生成してください。

3. Selection Inspectorの中の Show Frustumチェックボックスをクリックし、3D

ビューを回転させます。

4. アニメーションを少しだけ再生 しましょう。このとき、選択領域は固定
されたまま、どのセルが領域内あるいは領域外へ移動するかによって、選択要
素が変化していることに注意して下さい。
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5. もしまだ表示させていなければ、セレクション・インスペクタをView → Selection

Inspectorによって表示させて下さい。セレクション・インスペクタの画面の
内容をよく見えるようにするには、どこか別の場所にドッキング、またはアン
ドッキングさせる必要があるかもしれません。

6. Selection Typeを IDsに変更してください。

7. もう一度再生 してください。今度は、選択されたセルが位置にかかわら
ず変化しないことに注意して下さい。

まとめると、(表面および内部のセルまたは点を選択するツールによって作成され
る) 空間的な選択では、要素が選択領域の内外へ移動するのに対し、それぞれの時
刻ステップごとに選択を実行します。それに対し IDによる選択では、選択された点
やセルは変わらず、アニメーションに伴ってそれら自体の移動するのにつれて動き
ます。 �

スプレッドシート・ビューは選択と組み合わせて使い、分析を掘り下げるために
重要なツールです。スプレッドシート・ビューでスカラー場の実際の数値を読むこ
とができ、また選択の仕組みも活用することで目的の数値を特定しやすくなります。

演習 2.19: スプレッドシート・ビューと選択

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.16を参照)。

2. 垂直方向にビューを分割 して下さい。

3. 新しいビューにて、Spreadsheet Viewボタンをクリックしてください。

4. もし can.ex2が見えていなかったら、(対応する をクリックして) 見えるよ
うにしてください。

お分かりのとおり、スプレッドシート・ビューはかなり簡潔で、フィールド・デー
タを (例えば、ポイント・データまたはセル・データといった) フィールドの型ごと
に、表形式で表示します。このフィールド型の制限は、全ての行が確実に同じ列数
のデータを含むようにするために設けられています。
スプレッドシート・ビューの上部のウイジェットに注目して下さい。これらによっ
て、パイプライン・オブジェクトの選択、表示するフィールド型の選択、浮動小数
点数値の精度の選択、そして選択以外の全てを隠すことが素早く行えるようになっ
ています。どのビューにせよ、スプレッドシート・ビューにはそれ自身のDisplay パ
ネルがついてきます。
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5. Attributeのコンボ・ボックスから Cell Dataを選びます。

6. スプレッドシート・ビューをスクロールして、ハイライトされた行を探しま
す。(Displayパネルにて、異なるブロックを選択しなければならないかもしれ
ません。)

それらのハイライトされた行は、現在選択中の要素の一部です。このようなビュー
間の選択の連携は、複数のビューを関連付ける重要な仕組みです。とはいえ、この
例では、スプレッドシート・ビューにおいて選択された要素を識別するのは難しい
かもしれません。時には、選択されたデータだけを見たいこともあります。

7. スプレッドシート・ビュー上部の Show only selected elements をクリックし
てオンにしてください。

3Dビューにおいて作成された選択に含まれる要素のみが、スプレッドシート・
ビューに現れるのが見て取れました。この関連付けは、逆方向にも働きます。すな
わち、スプレッドシート・ビューで選択を作成すると、それらは 3Dビューにも表示
されます。

1. Show only selected elementsのチェックを外します。
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2. スプレッドシート・ビューで２～３行を選択します。

3. 3Dビューで選択された結果を探します。

�

スプレッドシートによって、フィールド・データを最も読みやすい形で表示する
ことができます。しかしながら、3Dビューに直接フィールド・データを表示するの
が便利であることもあります。次の演習では、そのための方法を解説します。

演習 2.20: 選択にラベルを付ける

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.16を参照)。

2. もし、ここまでの演習で幾つかのセルを選択していなければ、ここで幾つかを
選択して下さい。(この演習では、大量のセルを選択する必要はありません。)

3. まだ表示させていなければ、View → Selection Inspectorによってセレクショ
ン・インスペクタを表示させて下さい。

4. Selection Inspector内の (下部にある) Cell Labelタブをクリックします。

5. Visibleのチェックを入れます。

6. Label Modeを EQPSに変更します。

この操作によって、EQPSフィールドの値が、その値を含んでいる選択されたセ
ルの近くに表示されます。セレクション・インスペクタによって、フォントの種類、
大きさ、色を変更することも可能です。 �

ParaViewでは、フィールド・データを時間に沿ってプロットできます。全部のデー
タを全ての時刻ステップでプロットしたいことは滅多にないでしょうから、これら
のプロットは選択部分に対して行われるようになっています。

演習 2.21: 時間に沿ってプロットする
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1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.16を参照)。

2. もし、ここまでの演習で幾つかのセルを選択していなければ、ここで幾つかを
選択して下さい。(この演習では、大量のセルを選択する必要はありません。)

3. 選択が有効な状態で、Plot Selection Over Timeフィルタを追加してください
(Filters → Data Analysis → Plot Selection Over Time か、Windows/Linux

ではCtrl+Space、MacではAlt+Spaceのクイック起動を使用して下さい)。

4. をクリックします。

5. Displayパネルで、プロットする別のブロック (選択した要素のそれぞれと一致
します) を選択してください。

Object Inspectorにて、選択していた部分がプロットすべき選択として自動的に
追加されていることに注意して下さい。選択を変更するには、新たな選択を行って
Object Inspectorの Copy Active Selectionをクリックします。 �

また、選択された点やセルを個別に見たり、それらについてのみ何らかの処理を
行うために、選択部分を抽出することもできます。これは Extract Selection フィ
ルタによって行われます。

演習 2.22: 選択の抽出

1. もし、ここまでの演習で読み込んでいなければ、can.ex2を開き、全ての変数
を読み込む設定とし、 をクリックします (演習 2.16を参照)。

2. もし、まだ表示されていれば、セルのラベル表示をオフにします (Selection

Inspectorを確認して下さい)。
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3. 内部も含めたセルの選択 (Select Cells Through) で、多めのセルを選択し
ます。

4. Extract Selection フィルタを適用します (Filters → Data Analysis → Extract

Selectionか、Windows/LinuxではCtrl+Space、MacではAlt+Spaceのクイッ
ク起動を使用して下さい)。

5. をクリックします。

ビュー内のオブジェクトは、選択したセルに置き換えられます。(この画像では、
抽出したセルを全体のデータと関連させて見せるために、半透明な表面と、もとの
選択部分を示すもう一つのビューを加えています。) フィルタを選択部分を抽出し
たパイプライン・オブジェクトに単に付加するだけで、抽出されたセルに対しての
演算を行うことができます。 �

これで選択の演習を完了しましたので、Selection Inspectorを今後使うことはあり
ません。必要なら、閉じても構いません。

2.11 時間の制御
ParaViewには、時間とアニメーションを制御する強力な設定が多数あります。こ
れらの大多数は、アニメーション・ビューを通じて利用します。メニューから、View

→ Animation Viewをクリックします。

まず、アニメーション・ビューの上部にあるウイジェットを試してみましょう。ア
ニメーションのモード設定は、ParaViewがどのように再生中に時間を進めるかを定
義します。3つのモードを利用できます。
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Sequence (シーケンス) 開始、終了時刻を与えれば、アニメーションを決められた
フレーム数に等間隔に分割します。

Real Time (リアル・タイム) ParaViewは決められた秒数の再生時間となるよう、
アニメーションを再生します。実際のフレーム数は、フレーム間の更新時間に
依存します。

Snap To TimeSteps (時刻ステップにスナップする) ParaViewはデータで定義さ
れた時刻ステップどおりに再生します。

時間を含んだファイルを読み込むときは常に、ParaViewは自動的にアニメーショ
ン・モードを Snap To TimeStepsに変更します。そのためデフォルトでは、データ
を読込んで、再生 を押せば、データで定義されたとおりの各時刻ステップを見
ることができます。これが最も一般的な使い方です。
それ以外の使い方は、シミュレーションの書出したデータの時刻ステップ間隔が、
可変であるときに発生します。このような場合にはおそらく、時間のインデックス
よりも、シミュレーション上の時間に従ってアニメーションを再生したいでしょう。
問題ありません。残り 2つのアニメーション・モードのうちの 1つに切り替えられ
ます。別の使い方は、再生速度を変えたい場合です。アニメーションの速度を速く
したり、遅くしたいことがあるでしょう。残り 2つのアニメーション・モードでは、
それができます。

演習 2.23: アニメーション・モードによって、アニメーションの再生
速度を下げる
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。

1. can.ex2を開き、全ての変数を読み込む設定とし、 をクリックします
(演習 2.16を参照)。

2. ボタンをクリックして、カメラをメッシュに向けて下さい。

3. ツールバーの再生ボタン をクリックして下さい。

アニメーションの間、ParaViewは元のデータに定義されたそれぞれの時刻ステッ
プを、ただ一度だけ読み込んで表示します。アニメーションが再生される速度に注
意して下さい。

4. もし、まだ表示させていなければ、View → Animation Viewでアニメーション・
ビューを表示させて下さい。

5. アニメーション・モードをReal Timeに変更して下さい。デフォルトでは、ア
ニメーションはデータで指定されたとおりの時間の範囲となり、再生時間は 10

秒間になっています。
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6. もう一度、アニメーションを再生 します。

結果は前の Snap To TimeStepsによるアニメーションに似ていますが、今回はシ
ミュレーション上の時間に比例してアニメーションが進行し、10秒間で完了します。

7. Durationを 60秒に変更して下さい。

8. もう一度、アニメーションを再生 します。

アニメーションは明らかに、ゆっくりと再生されます。使用しているコンピュー
タでの画面更新が遅くなければ、アニメーションが前に比べて断続的になっている
ことにも気づくでしょう。これはデータセットの時間解像度を上回ったからです。�

元のデータに起因する、断続的なアニメーションの表示は多くの場合、望ましい
挙動と言えます。データの中でまさにどれが表示されているかが分かるからです。
しかし、プレゼンテーション用にアニメーションを作りたいのなら、より滑らかな
アニメーションが求められるでしょう。

ParaViewには、これを可能にする特別なフィルタが存在します。それはテンポラ
ル・インターポレータと呼ばれています。このフィルタは、メッシュ座標等の位置
的データおよびフィールド・データに対して、元のデータセットで定義された時刻
ステップの間を補間します。この機能は、最近のParaViewとVTKパイプライン構
造の進歩によって可能になりました。

演習 2.24: Temporal Interpolation

この演習は、演習 2.13の続きです。この演習を始める前に、演習 2.13を完了してお
く必要があります。

1. パイプライン・ブラウザの can.ex2がハイライト表示されていることを確認し
て下さい。

2. Filters → Temporal → Temporal Interpolatorを選択するか、クイック起動 (Win-

dows/Linuxでは Ctrl+Space、MacではAlt+Space) を使用して Temporal In-

terpolatorフィルタを適用します。

3. をクリックして下さい。

4. 必要なら、Animation Inspectorで Real Timeモードに戻って下さい。

5. ビューを分割 し、一方に TemporalInterpolator1を、他方に can.ex2を表示
し、カメラをリンクして下さい。

6. アニメーションを再生 して下さい。
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テンポラル・インターポレータの出力の方が、元のデータよりも大幅にスムーズ
に再生されることがお判り頂けるでしょう。 �

テンポラル・インターポレータの使用によって、不自然な結果を招きうる (そして、
それは実際、しばしば起きる)ことは指摘しておく必要があるでしょう。ParaViewが
この種の補間を決して自動的に行わないのはそれが理由であり、Temporal Interpolator

は明示的に適用する必要があります。また、一般的には、メッシュの変形は多くの
場合上手く補間されますが、一定のメッシュの下で移動する場は上手く補間されま
せん。さらに、Temporal Interpolatorは、トポロジが変化しない場合にのみ動作する
ことにも注意して下さい。もし、メッシュが時刻ステップによって変化する適応メッ
シュの場合は、Temporal Interpolatorはエラーとなります。

2.12 テキストによる注釈
ParaViewをコミュニケーションのための道具として用いるとき、作成した画像に
テキストの注釈をつけることは時に役に立ちます。ParaView 3では、3Dビューに
いつでも好きな時に注釈をつけることが非常に簡単になりました。ビュー内に単に
テキストを配置する特別なテキスト・ソースがあります。

演習 2.25: テキストによる注釈の追加
この演習を演習 2.24の続きとして行っているのであれば、そのまま続けて頂いて構
いません。もし、ParaViewを再起動したり、ParaViewの状態が演習を続けるに相
応しくなければ、新たな状態から始めて頂いても構いません。

1. メニューバーから、Sources → Textを選択します。

2. オブジェクト・インスペクタのテキスト入力欄に、適当な文を入力します。

3. ボタンをクリックします。

入力したテキストは、3Dビュー内に現れます。マウスでドラッグするだけで、好
きなところにこのテキストを配置できます。オブジェクト・インスペクタのDisplay
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タブでは、テキストのサイズ、フォント、色の追加設定ができます。また、テキス
トを最もよく使う位置に配置するためのボタンもあります。

�

しばしばアニメーション上の現在の時刻の値を、テキスト注釈に入れる必要があ
るでしょう。標準のテキスト・ソースで現在の時間の値を入力するのは退屈で、間
違いを起こしやすく、さらにアニメーションを作る時は、これが不可能です。そこ
で、現在のアニメーションの時刻を文字列に挿入する特別なアノーテート・タイム・
ソースがあります。

演習 2.26: アノーテート・タイムを追加する

1. 前の演習から読み込んでいなければ、can.ex2ファイルを開き、 をク
リックします。

2. Animate Time ソースを追加します (Sources → Annotate Time か、Win-

dows/Linuxでは Ctrl+Space、Macでは Alt+Spaceのクイック起動を使用し
ます)。

3. 必要ならば、注釈の位置を適宜移動します。

4. 再生 し、時刻の注釈がどう変化するか観察します。
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現在のアニメーションの時刻が、データ・ファイルから読み込まれた時刻ステッ
プと同じでない場合があります。時には、データ・ファイルに保存されている時刻
がいつであるかを知ることが重要なことがありますが、そのような場合には、フィ
ルタとして機能するアノーテート・タイムの特別版を使用することができます。

5. can.ex2を選択します。

6. クイック起動 (Windows/Linuxでは Ctrl+Space、MacではAlt+Space) を使
用し、Annotate Timeフィルタを適用します。

7. をクリックします。

8. 必要ならば、注釈の位置を適宜移動します。

9. Animation Viewで、アニメーション・モードを確認して下さい。もし Snap to

TimeStepsになっていれば、Real Timeに変更して下さい。

10. 再生 をクリックして、時刻の注釈がどう変化するか観察して下さい。

�

2.13 アニメーション
私たちは既に、時間を含むデータ・セットをアニメーションさせる方法を見てき
ました ( を押します)。しかし、ParaViewのアニメーション能力はそれ以上の
ものです。ParaViewでは、全てのパイプライン・オブジェクトのほぼ全てのプロパ
ティをアニメーションさせることができます。

演習 2.27: プロパティをアニメーションさせる
新たな可視化を始めますので、ここまでの演習を行っていた場合は、ParaViewをリ
セットする良い機会です。そのためには、 ボタンを押すのが最も簡単です。
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1. スフィア・ソースを作成 (Sources → Sphere) し、 をクリックします。

2. アニメーション・ビュー・パネルが表示されていることを確認して下さい (表
示されていなければ、View → Animation Viewを選択して下さい)。

3. No. Framesの設定を 50に変更します (10では速すぎるでしょう)。

4. アニメーション・ビュー下部のプロパティ選択ウィジェットで、1つ目のボッ
クスで Sphere1を、2つ目のボックスで Start Thetaを選択します。

ボタンをクリックします。

このアニメーションを再生 させると、球が展開して、ついには開ききって消
滅するのが見られるでしょう。

�

ここで行ったことは、Sphere1オブジェクトの Start Thetaプロパティのためのト
ラックを作成することです。トラックは、アニメーション・ビュー内の水平のバーで
表されます。そのバーには、ある特定の時刻における、そのプロパティの値を指定
するためのキー・フレームが保持されています。そのプロパティの値は、キー・フ
レームの間で補間されます。トラックを作成すると、開始時刻における最小値と終
了時刻に置ける最大値を保持するそれぞれのキー・フレームが自動的に作成されま
す。ここで設定したプロパティによって、球の開始角度の範囲が決まります。
トラックはその上でダブルクリックすることで、修正できます。ダブルクリック
するとダイアログ・ボックスが表示され、キー・フレームを追加、削除および修正
することができます。
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この機能を、アニメーションに新たなキー・フレームを追加するのに使います。

演習 2.28: アニメーション・トラックのキー・フレームを変更する
この演習は、演習 2.27の続きです。この演習を始める前に、演習 2.27を完了させて
おく必要があります。

1. Sphere1 – Start Thetaトラックをダブルクリックします。

2. Animation Keyframesダイアログ内の、Newボタンをクリックします。これで
新たなキー・フレームが作成されます。

3. 1番目のキー・フレームの値を 360に変更します。

4. 2番目のキー・フレームの時刻を 0.5に変更し、値を 0に変更します。

5. OKをクリックします。

アニメーションを再生すると、球ははじめ大きくなり、その後また小さくなりま
す。2 �

アニメーションさせられるのは 1つのプロパティだけではありません。必要なだ
けの数のプロパティを、アニメーションさせることができます。ここでは、2つのプ
ロパティを変更するようなアニメーションを作成してみましょう。

演習 2.29: 複数のアニメーション・トラック
この演習は演習 2.27と演習 2.28の続きです。この演習を始める前に、これらの演習
を完了させておく必要があります。

2原注: ParaView 3.6.1には、トラックの変更が常に更新されるとは限らないバグがあります。も
し Start Thetaトラックへの変更が反映されなければ、 ボタンをクリックして、もう一度試して
みて下さい。
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1. Sphere1 – Start Thetaトラックをダブルクリックします。

2. Animation Keyframesダイアログで、(時刻ステップ 0の) 最初のキー・フレー
ムを、Deleteボタンをクリックして削除します。

3. OKをクリックします。

4. アニメーション・ビューで、Sphere1オブジェクトの End Thetaプロパティの
ためのトラックを作成します。

5. Sphere1 – End Thetaトラックをダブルクリックします。

6. 2番目のキー・フレームの時刻を 0.5に変更します。

このアニメーションでは、球が生成・消滅するのが見られますが、今回は球形状
の描画範囲の変化部分が同じ方向に回転しています。それによって、このアニメー
ションをループ させたときに、とても満足できるアニメーションとなっていま
す。 �

パイプライン・オブジェクトのプロパティをアニメーションさせるのに加えて、
カメラをアニメーションさせることもできます。ParaViewには、指定された曲線
に沿ってカメラを動かす機能があります。最も一般的なアニメーションは、カメラ
をオブジェクトの周りで、常にオブジェクトの方向を向けながら回転させるもので
しょう。ParaViewには、そのようなアニメーションを自動的に生成する方法があり
ます。

演習 2.30: カメラを周回させるアニメーション
この演習では、何らかの読み込まれたデータに対してカメラを周回させます。もし
以前の演習からの続きでこの演習行うのであれば、そのまま続けることができます。
そうでなければ、何らかのデータを読み込むか作成して下さい。効果を確認するに
は、読み込むデータが非対称な形状であることが最適です。can.ex2は、この演習の
ために読み込むデータセットとして良いデータでしょう。

1. カメラを周回を始めたい点に設定します。カメラは、視点の右側に移動して行
きます。
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2. アニメーション・ビュー・パネルが表示されていることを確認して下さい (表
示されていなければ、View → Animation Viewを選択して下さい)。

3. プロパティ選択のウイジェットで、最初のコンボ・ボックスではCameraを、2

番目のコンボ・ボックスではOrbitを選択します。

ボタンをクリックします。

新たなトラックが作成される前に、周回軌道の設定ダイアログ・ボックスが表示
されます。デフォルトの値は現在のカメラ位置から決定され、通常これらの値のま
まで構いません。

4. OKをクリックして下さい。

5. 再生 をクリックして下さい。

これで、カメラがオブジェクトの周りを周回します。 �
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サンディア国立研究所では、ここに示した例のようなRed Stormスーパーコンピ
ュータで実行された大規模シミュレーションのデータを可視化するために、ParaView

を頻繁に使用しています。左上の画像は、ゴレブカ小惑星の中心で起爆した 10メガ
トン爆発の、10億セル以上の規模でのCTHによる衝撃波シミュレーションです。右
上の画像は、高緯度で極大気を捕捉する極周囲のジェット気流である極渦の崩壊の、
10億セル以上の規模でのSEAM気候モデルシミュレーションです。左下は、横風火災
における物体の、1000万の非構造 6面体格子による SIERRA/Fuego/Syrinx/Calore

を用いた弱連成シミュレーションです。右下は、AMRデータを生成するCTHによ
るシミュレーションです。ParaViewは、数十億セル、数十万ブロック、そして 11レ
ベルの階層構造からなるCTHのシミュレーションによるAMRデータの可視化に使
用されてきました (ここでは示しませんが)。
本節では、ParaViewの並列可視化機能を用いて、このような大規模メッシュを可
視化する方法を解説します。本節は前節ほど実践的ではありません。その代わり、大
規模な並列可視化を行うための概念的な知識を学んで頂くことになります。ここで
は基本的な ParaViewの構造および並列アルゴリズムを示し、これらの知識をどの
ように利用するかを実演します。
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3.1 ParaViewの構造
ParaViewは 3層のクライアント・サーバ構造になっています。ParaViewにおけ
るそれら 3つの論理的なユニットは、以下のとおりです。

データ・サーバ データの読込み、フィルタリング、書出しを担当するユニットです。
パイプライン・ブラウザに表示される全てのパイプライン・オブジェクトは、
データ・サーバが保持しています。データ・サーバは並列実行が可能です。

レンダー・サーバ レンダリングを担当するユニットです。レンダー・サーバも並列
実行が可能で、その場合は内蔵の並列レンダリング機能が有効化されます。

クライアント 可視化の作成を担当するユニットです。クライアントはサーバにおけ
るオブジェクトの作成、実行、削除を制御しますが、実際のデータは全く保持
しません (そのため、クライアントがボトルネックとなることが無く、サーバ
が大規模データへとスケーリングすることができます)。GUIもまた、クライ
アントに含まれます。クライアントは常にシリアルに実行される、非並列化ア
プリケーションです。

これらの論理ユニットは、物理的に分割されている必要はありません。論理ユニッ
トは多くの場合、同一のアプリケーションに含まれ、それらのユニット間での通信
を不要としています。ParaViewは、以下の 3つのモードで実行されます。

最初のモードはスタンドアローン・モードで、既に使用してきたとおりのモード
です。スタンドアローン・モードでは、クライアント、データ・サーバ、レンダー・
サーバは全て一つのシリアル実行アプリケーションに統合されています。paraview

アプリケーションを実行すると、ParaViewの全ての機能をすぐに使えるよう、ビル
トイン・サーバに接続されています。
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2つ目のモードはクライアント－サーバ・モードです。クライアント－サーバ・
モードでは、pvserverプログラムを並列マシン上で実行し、それに paraviewクラ
イアント・アプリケーションを接続します。pvserverプログラムはデータ・サーバ
とレンダー・サーバの両方を含んでおり、したがってデータ処理とレンダリングの
両方が pvserverで実行されます。クライアントとサーバはソケットを通じて接続
します。ソケット通信は比較的低速な通信手法であるため、このソケットを通じた
データ転送量は最小に抑えられています。

3つ目のモードは、クライアント－レンダー・サーバ－データ・サーバ・モードで
す。このモードでは、全ての 3つの論理ユニットが個別のプログラムとして実行さ
れます。クライアント－サーバ・モードと同様、クライアントはレンダー・サーバ
に 1つのソケットによって接続されます。レンダー・サーバとデータ・サーバはレ
ンダー・サーバのプロセスそれぞれにつき 1つづつ、多数のソケットによって接続
されます。ソケットを通じたデータ転送量は最小に抑えられています。
クライアント－レンダー・サーバ－データ・サーバ・モードはサポートされては
いますが、このモードはまず推奨されません。このモードの元々の意図は、大規模
でパワフルな計算プラットフォームと、小規模なグラフィックス・ハードウエアが
内蔵された並列マシンからなる異種混在環境を活用することでした。しかしながら
実際には、データ・サーバからレンダー・サーバへの転送所要時間によって、あら
ゆる利点が相殺されてしまうことが判りました。もし計算プラットフォームのほう
がグラフィックス・クラスタより非常に大きい場合は、ソフトウエア・レンダリン
グを使用して下さい。もし両プラットフォームが概ね同じ規模である場合は、グラ
フィックス・クラスタで全ての処理を実行して下さい。

3.2 ParaViewサーバのセットアップ
スタンドアローンのParaViewをセットアップするのは通常、難しくありません。
コンパイル済みのバイナリをダウンロードし、コンピュータにインストールすれば、
すぐに実行可能です。しかしながら、ParaViewサーバのセットアップはどうしても、
それよりは難しくなります。まず、サーバを自前でコンパイルしなければなりませ
ん。並列プログラミングのためのライブラリであるMPIには様々な種類のものがあ
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り、さらに個々のMPIは並列コンピュータの通信ハードウエアに合わせて変更が可
能であるため、全ての考えうる組合せについて信頼できるバイナリファイルを提供
するのは不可能です。

ParaViewを並列マシンでコンパイルするには、以下が必要です。

• CMake クロスプラットフォーム・ビルディング・ツール (www.cmake.org)

• MPI

• OpenGL (または、他に利用可能なものが無ければMesa 3D www.mesa3d.org)

• Qt 4.3 (オプション)

• Python (オプション)

オプションのライブラリ無しでコンパイルした場合は、それに対応する機能を利
用できなくなります。Qt無しでコンパイルした場合は、GUIアプリケーションを利
用できません。Python無しでコンパイルした場合は、スクリプト機能を利用できま
せん。

ParaViewをコンパイルするには、まずCMakeを実行し、コンパイルのための設
定とシステム上のライブラリの指定を行います。これによってMakefileが生成され、
そのMakefileを使用してParaViewをビルドします。ParaViewサーバのビルドに関
するさらなる詳細については、ParaView Wikiをご覧下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Compiling

ParaViewを並列に実行するのもまた、必然的にスタンドアローンのクライアント
を実行するより難しくなります。リモート・コンピュータにログインし、並列ノー
ドを確保し、並列プログラムを起動し、接続を確立し、ファイアウオールのトンネ
リングを行うといった、実行環境に依存する幾つもの段階を経る必要があります。
クライアント－サーバ間接続は、paraviewクライアント・アプリケーションに
よって確立されます。サーバに接続し、またサーバへの接続を解除するには、 お
よび ボタンを使用します。ParaViewの起動時には、ビルトイン・サーバという
特別なサーバに自動的に接続されます。また、サーバへの接続が解除された時にも、
常にビルトイン・サーバに接続されます。それら両者の例は、既に見たとおりです。

ボタンをクリックすると、接続可能な既知のサーバのリストを含んだダイア
ログが現れます。このサーバのリストはサイト、またはユーザごとに設定できます。

http://www.cmake.org
http://www.mesa3d.org
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Compiling
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どのようにしてサーバに接続するかは、Add ServerボタンをクリックしてGUIで
設定するか、または XMLの設定ファイルによって設定することができます。サー
バ接続を指定するための方法は幾つかありますが、最終的にはサーバを起動するた
めのコマンドと、サーバの起動後に接続するためのホスト名を設定することになり
ます。サーバ接続の確立に関するさらなる詳細については、ParaView Wikiをご覧
下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Running the Server

3.3 並列可視化アルゴリズム
ひとたび並列化のフレームワークさえ作成すれば、並列可視化を行うのは単純で
ある点で、私たちは幸運といえます。データはメッシュに含まれていますから、そ
れはすなわち、既にデータがセルによって細かな断片に細分化されていることにな
ります。それらのセルをプロセスごとに分割することで、分散並列マシン上で可視
化を行うことができます。具体的に示すため、以下の非常に簡略化されたメッシュ
を考えます。

このメッシュについて、3つのプロセスを使用して可視化を行いたいとします。以
下に青、黄、ピンク色の領域で示すように、このメッシュのセルを分割します。

http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Running_the_Server
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ひとたび分割されれば、幾つかの可視化アルゴリズムは、それぞれのプロセスに
おいてローカルに保持されるセルに対してアルゴリズムを独立に実行することで、
処理することができます。クリッピングを例にしましょう。クリッピングを行う切
断面を定義し、この切断面をそれぞれのプロセスに与えます。

それぞれのプロセスは、この切断面によって独立にクリッピングを行うことがで
きます。最終的に得られる結果は、このクリッピングをシリアルに実行した場合と
同じです。(大規模データでは明らかに、絶対に行うべきではありませんが) これら
のセルをもし、再び結合したとすれば、クリッピング演算が正しく行われたことが
わかります。

3.4 ゴースト・レベル
しかしながら残念なことに、可視化アルゴリズムを分割されたセルに対して闇雲
に実行しても、必ず答えが正しいとはとは限りません。簡単な例として、外部界面ア
ルゴリズムを考えて下さい。外部界面アルゴリズムとは、1つのセルにのみ属する
セル界面のすべてを探索する、すなわちメッシュの境界面を特定するアルゴリズム
です。
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おっと。全てのプロセスが外部界面アルゴリズムを個別に実行すると、多くの内
部界面が外部界面として誤って特定されるのが判ります。これは、あるパーティショ
ンのセルが別のパーティションのセルに隣接するところで起こります。プロセスが
別のパーティションのセルにアクセスする方法がありませんので、これらの隣接セ
ルが存在することを知る方法はありません。

ParaViewや、その他の並列可視化システムで採用されている解決法は、ゴース
ト・セルの利用です。ゴースト・セルとは、あるプロセスによって保持されていま
すが、実際には別のプロセスに属するセルのことです。ゴースト・セルを使用する
には、それぞれのパーティションにおける全ての隣接セルを特定しなければなりま
せん。そして、それらの隣接セルをそのパーティションにコピーし、コピーされた
セルをゴースト・セルとして、以下の例では灰色のセルで示されるようにマークし
ます。

外部界面アルゴリズムをゴースト・セルに対して実行すると、それでもなお幾つ
かの内部界面を外部として誤って特定しているのが判ります。しかしながら、これ
らの全ての誤って特定された界面はゴースト・セルに属しており、したがってそれ
らの界面は属するセルの「ゴーストである」との状態を継承しています。それらの
「ゴーストな」界面は ParaViewによって取り除かれ、正しい解に辿り着きます。
この例では 1層のゴースト・セル、すなわちパーティション内のセルに直接隣接す
るセルのみを示しました。ParaViewでは、複数の層からなるゴースト・セルを取出
すことが可能です。すなわち、それぞれの層が、下のゴースト層あるいは元のデー
タそのものに含まれていない一つ下の層の隣接セルを含んでいます。これは、それ
ぞれがゴースト・セルの層を必要とするようなフィルタを直列に使用する際に便利
です。それらのフィルタは、それぞれ上流側に対して追加のゴースト・セルの層を
要求し、下流側へデータを送る際に 1層だけ取り除きます。

3.5 データの分割
ここではデータを分割して分散させるため、データの分割法の影響に関して議論
しておくこととします。前述の例で示されたデータは空間的にコヒーレントな分割
法と言えます。すなわち、各パーティションのセルは全て空間中のコンパクトな領
域に存在しています。その他にもデータを分割する方法は存在します。例えば、ラ
ンダムに分割する方法も有り得ます。
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ランダム分割には、良い面があります。というのも、パーティションの作成およ
び負荷分散が容易であるからです。しかしながら、ゴースト・セルに関しては、深
刻な問題が存在します。

この例では、1層のゴースト・セルによって、全プロセスにおいてデータセット
のほぼ全体が複製されてしまっていることが判ります。したがって、並列処理の利
点がほぼ失われてしまっています。ParaViewにおいてゴースト・セルは頻繁に使用
されるため、ParaViewではランダム分割は使用されていません。

3.6 D3フィルタ
前節では、並列可視化のための負荷分散およびゴースト・セルの重要性を述べま
した。本節では、負荷分散のための方法を述べます。
負荷分散およびゴースト・セルは、構造データ (画像データ、直線格子、および構
造格子) を読み込んだ際には、ParaViewによって自動的に取扱われます。構造デー
タが暗黙に有するトポロジのために、データを空間的にコヒーレントなパーティショ
ンに分割し、隣接セルの位置を特定するのが容易であるためです。
ところが、非構造格子 (ポリ・データおよび非構造格子) を読み込む際には、全く
異なった状況になります。非構造格子には、暗黙のトポロジや隣接セルの情報があ
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りません。このときの ParaViewの動作は、どのようにデータがディスクに書かれ
たかに依存します。したがって、非構造格子が読み込まれる際には、そのデータが
どの程度良好に負荷分散されるかについては保証されません。さらに、そのような
データがゴースト・セルの情報を含んでいる可能性は低いため、幾つかのフィルタ
の出力は正しくない可能性があります。
幸い ParaViewには、非構造格子の負荷分散を行って、ゴースト・セルを作成す
るためのフィルタがあります。このフィルタは、distributed data decomposition (分
散データ分割) の頭文字をとってD3と呼ばれます。D3フィルタの使用法は簡単で、
(Filters → Alphabetical → D3に存在する) このフィルタを、分割し直したいデータ
に適用するだけです。

D3の最も一般的な使い方は、非構造格子データ読み込みモジュールに対して直接
適用する方法です。読み込まれたデータが如何にうまく負荷分散されていても、以
降のフィルタが正しいデータを生成するよう、ゴースト・セルを抽出することは重
要です。上記の例は、ある非構造格子へ表面抽出フィルタを適用した結果の断面で
す。左図ではゴースト・セルが無いために、多くの界面が誤って抽出されているこ
とが判ります。一方で右図では、D3フィルタをまず最初に適用することで、その不
具合が修正されています。

3.7 ジョブ・サイズにデータ・サイズを合わせる
ParaViewサーバとして、幾つのプロセスを使用すべきでしょうか。これは多くの
重要な影響を含む、普遍的な質問と言えます。そしてまた、非常に難しい質問でも
あります。それぞれのプロセスにどのようなハードウエアが対応付けられているか、
どの程度の大きさのデータを処理しようとしているか、どのような型のデータを処
理しようとしているか、どのような種類の可視化操作を行おうとしているか、そし
てユーザ自身の我慢強さなどの要因によって、その回答は大きく左右されます。
したがって、確固たる回答はありません。しかしながら、幾つかの経験則はあり
ます。
構造データ (画像データ、直線格子、構造格子) に対しては、少なくとも 2,000万
セルにつき 1つのプロセッサが与えられるようにしてください。もしさらにプロセッ
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サを割り当てられるなら、500から 1,000万セルにつき 1プロセッサが与えられれ
ば、通常は充分です。
非構造データ (ポリ・データ、非構造格子) に対しては、少なくとも 100万セルに
対し 1プロセッサが与えられるようにしてください。もしさらにプロセッサを割り
当てられるなら、25万から 50万セルにつき 1プロセッサが与えられれば、通常は充
分です。
前述のように、これらは経験則に過ぎず、絶対的法則ではありません。常にデータ
量に対してどの程度のプロセッサが適切かを評価し、実験するように努めるべきで
す。そしてもちろん、読み込みたいデータの規模が、ユーザが利用可能な計算機資源
の限界を拡大する時が来る可能性は、常にあります。このような状況になれば、デー
タ量の爆発的増大を確実に回避し、データを確実に間引きたくなることでしょう。

3.8 データ量の爆発的増大の回避
ParaViewの有するパイプライン・モデルは、試行錯誤による可視化にはとても便
利です。コンポーネント間の連携が緩やかであるため、型どおりでない可視化の構
築のためのとても柔軟なフレームワークとなっています。また、パイプライン構造
のため、設定を素早く容易に追い込むことができるようになっています。
この連携方法の欠点は、メモリ使用量が比較的多くなることです。パイプライン
の各段階でそれぞれがデータを重複して保持するためです。ParaViewは可能な時
は常に、パイプラインの各段階がメモリ内の同一の領域のデータを参照するよう、
データの浅いコピーを行います。しかしながら、新たなデータを作成したり、デー
タの値やトポロジを変更するようなフィルタは全て、それらの結果のための新たな
メモリを確保せざるを得ません。ParaViewが非常に大きなメッシュに対してフィル
タを適用する場合には、フィルタの使用法が適切でなければ即座に利用可能なメモ
リを全て使い尽くしてしまいます。したがって、大規模なデータセットを可視化す
る際には、フィルタのメモリ所要量を理解しておくことが重要です。
ただし、以下の助言は非常に大規模なデータを取扱っていながら、使用可能なメ
モリが少なくなっている時のためのみであることに注意してください。メモリが尽
きる心配がなければ、以下の助言は全て無視してください。
構造データを扱っているときは、どのフィルタがデータを非構造データに変更す
るかを知っておくことは絶対的に重要です。なぜなら、非構造データは、トポロジを
明示的に記述する必要があるため、構造データよりもセルあたりのメモリ使用量が
大幅に増大するからです。ParaViewには、トポロジを何らかの方法で変更するフィ
ルタが数多く存在し、それらのフィルタは生成されるあらゆる種類のトポロジを扱
えるデータセットが非構造データのみであるため、データを非構造格子として書き
出します。以下にリストされたフィルタは、入力とおおむね等しい新たな非構造格
子トポロジを出力に書き出します。これらのフィルタは、絶対に構造データに対し
ては使用するべきではなく、非構造データに対してのみ注意しながら使用するべき
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です。

• Append Datasets

• Append Geometry

• Clean

• Clean to Grid

• Connectivity

• D3

• Delaunay 2D/3D

• Extract Edges

• Linear Extrusion

• Loop Subdivision

• Reflect

• Rotational Extrusion

• Shrink

• Smooth

• Subdivide

• Tessellate

• Tetrahedralize

• Triangle Strips

• Triangulate

技術的には、Ribbonおよび Tubeフィルタもこのリストに含まれます。しかしな
がら、それらはポリ・データ中の 1次元のセルにのみ作用するため、入力データは
通常小規模で、ほとんど影響はありません。
次の同様な一連のフィルタもまた、非構造格子を出力しますが、一般的にはその
データ量 (格子数) をいくらか削減します。ただし、このデータ量削減は多くの場
合、非構造格子への変換によるオーバーヘッドを補う程ではないことに注意して下
さい。また多くの場合、このデータ量の削減は (負荷分散の点では) あまり上手くバ
ランスしないことに注意して下さい。したがって、これらのフィルタは非構造デー
タに対しては注意深く、また構造データに対しては非常に注意深く使用する必要が
あります。

• Clip

• Decimate

• Extract Cells by Region

• Extract Selection

• Quadric Clustering

• Threshold

上のリストの項目と同様に、Extract Subset は構造データセットに対してデー
タ量削減を行いますが、構造データを出力します。したがって、新たなデータが作成
されるという注意点は同様ですが、非構造データに変換されるとの心配は不要です。
以下の一連のフィルタもまた非構造データを出力しますが、(3次元から 2次元へ
のような) データの次元の削減を行いますので、出力はずっと小さくなります。し
たがって、これらのフィルタは通常、非構造データに対しても使用することができ、
構造データに対しても多少の注意を払えば充分です。
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• Cell Centers

• Contour

• Extract CTH Fragments

• Extract CTH Parts

• Extract Surface

• Feature Edges

• Mask Points

• Outline (curvilinear)

• Slice

• Stream Tracer

これらのフィルタはデータのコネクティビティを全く変更しません。そのかわり、
データにフィールド配列のみを付加します。既に存在するデータに対しては浅いコ
ピーが行われます。これらのフィルタは通常、どのようなデータに対しても使用す
ることができます。

• Block Scalars

• Calculator

• Cell Data to Point Data

• Curvature

• Elevation

• Generate Surface Normals

• Gradient

• Level Scalars

• Median

• Mesh Quality

• Octree Depth Limit

• Octree Depth Scalars

• Point Data to Cell Data

• Process Id Scalars

• Random Vectors

• Resample with dataset

• Surface Flow

• Surface Vectors

• Texture Map to...

• Transform

• Warp (scalar)

• Warp (vector)

以下の最後の一連のフィルタは、データを出力に全く追加しない (全ての出力デー
タは浅いコピーによって得られる) か、付加されるデータは入力データの量に依存
しないフィルタです。これらはどんな状況でも、まず問題なく使用することができ
ます (ただし、処理時間は要するかもしれません)。

• Annotate Time

• Append Attributes

• Extract Block

• Extract Datasets

• Extract Level

• Glyph
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• Group Datasets

• Histogram

• Integrate Variables

• Normal Glyphs

• Outline

• Outline Corners

• Plot Global Variables Over Time

• Plot Over Line

• Plot Selection Over Time

• Probe Location

• Temporal Shift Scale

• Temporal Snap-to-Time-Steps

• Temporal Statistics

上記の分類には上手くあてはまらない、特殊なフィルタも存在します。それらの
フィルタの幾つか (今のところTemporal InterpolatorとParticle Tracer)は、データが
時間によってどのように変化するかに基づいて処理を行います。したがって、これ
らのフィルタは 2ステップ、またはそれ以上の時刻ステップを読み込む必要があり、
メモリ上で必要なデータの量が倍、またはそれ以上となる可能性があります。また、
時間軸方向の処理を行うフィルタの幾つか、例えばTemporal Statisticsや、時間軸に
沿ってデータをプロットするようなフィルタは、全てのデータをディスクから反復
的に読み込む必要があります。したがって、たとえ余分なメモリを使用しなくても、
非実用的なほど長い処理時間を要する可能性があります。

Programmable Filter もまた、分類が不可能な特殊なケースです。このフィルタ
はプログラミングされたとおりの処理を行いますので、これらの分類のいずれにも
あてはまる可能性があります。

3.9 データを間引く
大規模なデータを扱う際には、可能な限りデータを間引くことが明らかに最良の
策であり、それも早い段階で行うほど、良いといえます。ほとんどの大規模データ
は 3次元の形状として読込まれますが、所要の形状はそのデータの (表面などの) 面
であることがしばしばあります。面データの所要メモリは通常、その元となる立体
データよりも大幅に小さいため、早い段階で面データに変換するのが最良といえま
す。ひとたびそのようにすれば、他のフィルタを比較的安全に適用することができ
ます。
非常に一般的な可視化の操作としては、Contour フィルタを使用して立体デー
タから等値面を抽出することが挙げられます。Contourフィルタは通常、入力より
ずっと小さなデータ量の形状を出力します。したがって、いかなる状況であれ、も
し Contourフィルタを使用するのであれば、早い段階で適用するべきです。とはい
え、Contourフィルタは大量のデータを生成する可能性もありますので、設定には
注意して下さい。大量の等値面を生成する値を指定すれば、当然ながらそのような
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状況は起こり得ます。データ中の等値面を生成する値の上下に、ノイズのような高
周波の変動が存在すれば、それも大量の不整形な面を生成する原因となります。
立体データの内部を見るもう一つの方法は、Slice フィルタを適用することで
す。Slice フィルタは、立体データを面によって薄切りにして、立体内の面が切断
する部分のデータを見えるようにします。もし大規模データの中で興味深い特徴を
有する位置が既に判っていれば、薄切りにするのがそのデータを見る良い方法です。
もしもデータについてあらかじめ与えられた情報がほとんどなく、しかも全デー
タセットに対するメモリ量や処理時間を必要とすることなくデータを調べたいので
あれば、Extract Subset フィルタを使用してデータの一部の領域を抽出、および
間引くことができます。間引かれたデータの量を元のデータよりも大幅に小さくす
ることは可能でありながら、間引かれたデータは良好に負荷分散されているはずで
す。もちろん、間引くことによって細かなデータの変化は失われる可能性があり、必
要なデータの特徴を発見したら完全なデータセットに戻って可視化を行うべきであ
ることは注意して下さい。
立体データの一部を取り出すことのできるフィルタは幾つかあります。Clip 、

Threshold 、Extract Selection、そして Extract Subset はいずれも、何らかの
基準によってセルを抽出することができます。しかしながら、抽出されたセルが上手
く負荷分散されている可能性はほとんど無く、全くセルが取り除かれないプロセス
も存在する可能性に注意して下さい。また、Extract Subset 以外のこれらのフィ
ルタは全て、構造データ型を非構造格子に変換します。したがってこれらは、抽出
されたセルが元のデータより少なくとも一桁以上少なくなるのでない限り、使用す
るべきではありません。
可能であれば、3次元データを抽出するフィルタを 2次元の面を抽出するフィル
タで置き換えてみて下さい。例えば、データ中のある平面を調べたいのであれば、
Clip フィルタよりも Slice フィルタを使用して下さい。もしある範囲内の値
を含むセルの領域の位置を調べるのであれば、Threshold フィルタを使って全て
のセルを抽出するよりも、Contour フィルタを使ってその範囲の両端となる等値
面を生成するようにしてみてください。ただし、このように代わりのフィルタを使
用すると、下流側のフィルタに影響する可能性があることに注意して下さい。例え
ば、Threshold フィルタの後に Histogram フィルタを実行するのは、ほぼ同
等の Contour フィルタの後に実行するのとは全く異なった結果となります。

3.10 レンダリング
レンダリングとは、データから実際に目にする画像を生成する処理のことです。
データと効率的にインタラクションする能力は、レンダリングのスピードに大きく
依存します。コンピュータ・ゲーム市場に牽引された 3次元処理のハードウエア・ア
クセラレーションの進歩によって、高価でないコンピュータでさえ、3次元画像を
高速にレンダリングできるようになりました。しかしながらもちろん、レンダリン
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グの速度はレンダリングされるデータの量に比例します。データが大きくなるほど、
レンダリング処理は必然的に遅くなります。
可視化セッションが確実にインタラクティブに実行されるため、ParaViewは 2つ
のモードをサポートしており、それらのモードは必要に応じて自動的に切り替えら
れます。スティル・レンダーと呼ばれる 1つ目のモードでは、データは可能な限りの
ディテールを保持してレンダリングされます。このレンダリング・モードでは、確
実にデータの全てが正確に表現されます。インタラクティブ・レンダーと呼ばれる 2

つ目のモードでは、正確さよりも速度が優先されます。このレンダリング・モード
では、データの大きさにかかわらず、高速なレンダリングが行われるよう配慮され
ます。
マウスによる回転、パン、ズームなどの、3Dビューにおけるインタラクションを
行っている間は、ParaViewはインタラクティブ・レンダーを行います。これはイン
タラクションの間、これらの機能を実用的に保つため、高いフレームレートが必要
であるのと、インタラクションの間それぞれのフレームはすぐに次のフレームで置
き換えられるため、このモードにおいては精細なディテールはあまり重要でないた
めです。3Dビューにおけるインタラクションが行われていない時は、ParaViewは
データの全てのディテールが明らかになるよう、スティル・レンダーを使用します。
3Dビューでマウスをドラッグしてデータを動かすと、マウスを動かしている間は概
略のみがレンダリングされますが、マウスボタンを放すとすぐに完全なディテール
まで表現されるのがお判り頂けるでしょう。
インタラクティブ・レンダーは速度と正確さの妥協の産物です。したがって、いつ、
どのように粗いディテールが使用されるかについては、多くの設定が関係します。

3.10.1 基本的な設定
最も重要なレンダリング設定の幾つかは、LODに関する設定です。インタラク
ティブなレンダリングの間、形状は低いディテールのレベル(LOD)、すなわちより
少ないポリゴンで表現された近似的な形状に置き換えられることがあります。

形状の近似化の解像度は、変更することができます。形状簡略化のアルゴリズム
は、ポリゴンを粗い格子に沿って配置するように動作します。上の画像では、左の
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画像は完全な解像度です。中央の画像は 503分割の格子による形状簡略化の結果で、
右の画像は 103分割の格子による形状簡略化の結果です。

3次元レンダリングの設定は、メニューの Edit → Settings (Macでは ParaView →

Preferences) で現れる設定ダイアログボックスにあります。ダイアログを開くと、基
本的なレンダリング設定は Render View → General以下にあります。

レンダリング性能に関する設定は、以下のような意味があります。

Use Immediate Mode Rendering (イミディエイト・モード・レンダリングを使用する)

これをチェックすると、形状はグラフィックス・カードに送られてイミディエ
イト・レンダリングが行われます。チェックを外すと、形状はより効率的なレ
ンダリングのためにディスプレイ・リストにまとめられます。通常はディス
プレイ・リストの方が高速にレンダリングされますが、最初のフレームのレ
ンダリングの間にディスプレイ・リストを作成する時間、およびそれを保持
するメモリが必要となります。

Use Triangle Strips (トライアングル・ストリップを使用する) チェックを外す
と、データはポリ・データによって定義されたとおりにレンダリングされます。
チェックすると、データはトライアングル・ストリップに変換されます。トラ
イアングル・ストリップはグラフィックス・カードに効率的に転送され、より
高速にレンダリングされることもありますが、通常はそうではありません。

LOD Threshold (LODしきい値) どのような時に形状を簡略化された形状で置き
換えるかを制御します。チェックボックスは、この機能自体をオンまたはオフ
にします。オンの場合は、スライダによってこの機能の動作するしきい値を与
えます。形状のデータ量がこのしきい値未満であれば、その形状はレンダリン
グするのに充分小さいと見なされます。形状のデータ量がこのしきい値より大
きければ、簡略化された形状がレンダリングに使用されます。

Allow Rendering Interrupts (レンダリングの中断を許可する) チェックされて
いる場合、スティル・レンダーを中断してインタラクティブ・レンダーを行
えるようになります。
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3.10.2 基本的な並列レンダリング
並列可視化を行う際には、レンダリングに至るまで、およびレンダリング自体の全
てのプロセスにおいて、データが分割されているよう注意します。ParaViewでは、
IceTと呼ばれる並列レンダリング・ライブラリが使用されます。IceTでは、ソー
ト・ラスト・アルゴリズムが、並列レンダリングに使用されます。この並列レンダ
リング・アルゴリズムによって、それぞれのプロセスはそれぞれに与えられた分割
された形状を独立にレンダリングし、その結果の部分的な画像を重畳して最終的な
画像を生成することができます。

上の図は大幅に簡略化したものです。IceTには、2分木法やバイナリ・スワップ
法のような、いくつかの段階を用いて処理を効率的にプロセス間に分割する、複数
の並列化された画像重畳アルゴリズムが含まれています。

ソート・ラスト法による並列レンダリングの素晴らしい点は、その効率がレンダ
リングされるデータの量に全く依存しないことです。そのため、この手法は非常に
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スケーラブルで、大規模なデータに適しています。しかしながら、並列レンダリン
グのオーバーヘッドは画像中の画素数に対して線形に増加します。したがって、レ
ンダリング設定の幾つかは画像の大きさに関するものです。

IceTは、タイリング表示されたディスプレイ (多数の並べられたモニタやプロジェ
クタによって構成される、大型・高解像度のディスプレイ) を駆動する能力があり
ます。ソート・ラスト・アルゴリズムをタイリング・ディスプレイに使用するのは、
重畳すべき画素数が非常に多くなるため、やや直感的ではありません。しかしなが
ら IceTでは、それぞれのプロセスに存在するデータの特定の局所性を利用して、必
要な重畳処理を大幅に低減するようになっています。この空間的な局所性は、デー
タに対しD3フィルタを適用することで強制することができます。
並列レンダリングにはオーバーヘッドが存在するため、ParaViewではいつでも並
列レンダリングをオフにすることができます。並列レンダリングがオフの時は、形
状データが実際に表示が行われる所に転送されます。明らかに、これはレンダリン
グするデータが小さいときにのみ行うべきです。

3.10.3 並列レンダリングの設定
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他の 3次元レンダリングの設定と同じように、並列レンダリングの設定も Edit →

Settings (MacではParaView → Preferences)によって現れる設定ダイアログボックス
に配置されています。ダイアログを開くと、並列レンダリングの設定はRender View

→ Server以下にあります。それぞれの設定は、以下のような意味があります。

Remote Render Threshold (リモート・レンダリングを行うしきい値) こ の
チェックボックスは、リモート・レンダリングをオンまたはオフにします。ス
ライダによって、並列レンダリングを行うしきい値を変更することができま
す。形状のデータ量がこのしきい値未満であれば、形状データが表示が行わ
れる所 (通常はクライアント) に転送されます。

Disable Ordered Compositing (順序付け重畳を行わない) ボリューム・レンダ
リングおよび透明なポリゴンが正しく表示されるには、順序付け重畳と呼ば
れる特別な並列レンダリング・モードが必要です。しかしながら、このモード
には追加の計算処理とメモリが必要です。このチェックボックスをオンにする
と、順序付け重畳を行わなくなります。

Subsample Rate (間引き率) 並列レンダリングのオーバーヘッドは、生成された
画像の大きさに比例します。したがって、インタラクティブなレンダリングは、
画像を間引く割合を指定することで高速化することができます。このチェック
ボックスがチェックされている時は、インタラクティブ・レンダーでは低解像
度の画像を生成し、表示される時にその画像を拡大するようになります。こ
の設定はインタラクティブ・レンダーの時のみ使用されます。スティル・レン
ダーの時は、常に完全な解像度の画像が使用されます。

Squirt Compression (Squirt圧縮) 画像がサーバからクライアントに転送される
前に、その画像をSQUIRTと呼ばれるアルゴリズムによって圧縮することが
できます。このチェックボックスでは、この SQUIRT圧縮をオンまたはオフに
します。圧縮をさらに効果的にするために、SQUIRTでは圧縮前に画像の色深
度を削減することができます。スライダによって、削減する色深度のビット数
を指定します。デフォルトの 19ビットでは、ほとんどのディスプレイではま
ず違いが判りません。スライダによる設定は、インタラクティブ・レンダーの
時のみ有効です。スティル・レンダーの時は、常にフルカラーの色深度が使用
されます。

Still Subsample Rate (スティル・レンダーの間引き率) タイリング・ディスプレ
イは色々な用途に使われます。例えば、小規模な共同作業や大規模なプレゼン
テーションなどです。大規模なプレゼンテーションでは、観衆がディスプレイ
の全ての画素を見ることはまずありません。そのような場合には、このオプ
ションによってスティル・レンダーの画像を間引いて、レンダリングの時間を
大幅に短縮することができます。
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Client Collect (クライアントに集約する) タイリング・ディスプレイ・モードで
は、並列レンダリングによる画像はデスクトップでなく、タイリングされた
ディスプレイに送られます。したがって、クライアントは全てのデータをロー
カルにレンダリングしなければなりません。この設定では、クライアントに送
られるデータ量の上限を指定します。データが指定されたしきい値より大きけ
れば、クライアントにはデータが収まるバウンディング・ボックスのみが表示
されます。

Compositing Threshold (重畳を行うしきい値) 重畳を行うしきい値とは、タイ
リング・ディスプレイに対するリモート・レンダリングを行うしきい値と同等
のものです。ただし、重畳を行うことによる得失は異なります。タイリングさ
れたディスプレイは解像度が高いために重畳のオーバーヘッドは大きく、その
かわり通常は高速なネットワーク内で行われるため、形状の集約のオーバー
ヘッドは小さくなります。したがって、重畳を行うしきい値をリモート・レン
ダリングを行うしきい値よりも高くすると、効果のあることがあります。形状
のデータ量がこの重畳を行うしきい値より小さければ、表示される形状が全て
のレンダリング・ノードに送られ、それぞれのレンダリング・ノードはそれぞ
れが受け持つタイリング・ディスプレイの部分に直接レンダリングされます。

3.10.4 大規模データのための設定
デフォルトのレンダリング設定は、ほとんどのユーザに適しています。しかしな
がら、非常に大規模なデータを扱う時は、設定を追い込むことが有効であることが
あります。最適な設定はデータおよび ParaViewが実行されるハードウエアによっ
て変わりますが、以下のような助言に従うと良いでしょう。

1. Use Immediate Mode Renderingをオンにして、Use Triangle Stripsをオフにし
て下さい。これらの設定は両方とも、効率的にレンダリング可能な構造に変換
することが目的です。しかしながら、データが大規模なときは大抵、処理とメ
モリのオーバーヘッドがその効率化に見合いません。実際、メモリの限界が拡
大されれば、この設定によって性能は低下します。

2. LOD Thresholdをオフにしてみてください。大規模データにおいては、形状の
簡略化には長い時間がかかり、データに極端な曲がり部や特殊なコネクティビ
ティがあれば、良い結果が得られないことがあります。LODによって性能が改
善されるのであれば、LOD Resolutionの設定スライダを一番右 (10× 10× 10)

に動かしてみて下さい。

3. 常にリモート・レンダリングをオンにしておいてください (Remote Render

Thresholdの隣のチェックボックスで切り替えられます)。リモート・レンダリ
ングによってサーバ全体のレンダリング能力が使われ、クライアントに画像が
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転送されます。リモート・レンダリングがオフであれば、形状データがクライ
アントに転送されます。大規模なデータに対しては、形状データを転送するよ
りも画像を転送する方が必ず高速です。

4. 間引き処理をオンにして、Subsample Rateを必要に応じて調整して下さい。画
像の重畳に時間がかかる場合は、クライアントとサーバの間の接続が狭帯域で
あるか、非常に大きな画像をレンダリングしているときには間引き率を大きく
すると、インタラクティブ・レンダリングの性能が大幅に改善されることがあ
ります。

5. Squirt Compressionがオンであることを確認して下さい。この設定はデスクトッ
プへの画像表示性能に大きな影響があります。また、この設定によって引き起
こされる画質低下は最小限であり、かつ影響を受けるのはインタラクティブ・
レンダリング時のみです。
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第4章 Pythonによるバッチ・スクリ
プティング

ParaViewにおけるPythonによるスクリプティングは、主に 2つの用途に活用す
ることができます。1つはGUIでユーザが行うのと同じことを行って、設定や可視
化の実行を自動化することです。もう 1つは、Pythonスクリプトをパイプライン・
オブジェクトの中で走らせ、それによって並列可視化アルゴリズムを実行すること
です。本章では、最初のモード、すなわち可視化の自動化のためのバッチ的なスク
リプティングを述べます。
バッチ・スクリプティングは日常的な、あるいは繰返し行う処理の自動化に向い
ていますが、同時に、GUIの使用が望ましくない、あるいは使用できない状況で
ParaViewを使用するには必須の手法です。Pythonスクリプトを使用した自動化に
よって、ParaViewをスケーラブルな並列ポストプロセッシングのためのフレーム
ワークとして活用することができます。また筆者らは、シミュレーション・コード
内で、シミュレーションと同時に (in-situ) 可視化を行うためにも、Pythonによる
スクリプティングを使用しています。
このチュートリアルでは、Pythonによるスクリプティングの、ほんの導入的な解
説のみを行います。最新かつ、より詳しい解説は、ParaView Wikiに掲載されてい
ます。

http://www.paraview.org/Wiki/ParaView/Python Scripting

4.1 Pythonインタプリタの起動
Pythonインタプリタを起動するには、幾つかの方法があります。どの方法を使
用すべきかは、スクリプティングをどのように使用するかによります。Pythonイン
タプリタを使用するための、最も簡単で、かつこのチュートリアルで利用する方法
は、メニューからTools → Python Shellを選択することです。そうすると、Python

インタプリタを対話式に使用するためのテキスト入力エリアを持つダイアログが開
きます。

http://www.paraview.org/Wiki/ParaView/Python_Scripting
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もし、とにかく今すぐスクリプトを書いてみたいのであれば、以下のスクリプティ
ングを起動するための他の方法を飛ばして、次節まで進んで頂いても構いません。

ParaViewには、Pythonスクリプトを実行するためのコマンドライン・プログラム
が、2種類付属しています。すなわち、pvpythonと pvbatchです。それらは、コマ
ンドラインまたはファイルからPythonスクリプトを読込んで、それをPythonイン
タプリタに渡す点で、Pythonの配布物に付属の python実行ファイルと似ています。
pvpythonと pvbatchの違いは、可視化を行う際の、微妙な手法の違いによるもの
です。pvpythonは、paraviewのクライアントGUIにおけるGUIを、Pythonイン
タプリタに置き換えたものと概ね同等と言えます。pvpythonはシリアル実行され、
1つの ParaViewサーバ (ビルトイン、またはリモートのいずれも可) に接続される
アプリケーションです。それに対して pvbatchは、クライアントとのソケット通信
の代わりにPythonスクリプトによって動作を指示される点を除いて、pvserverと
概ね同等です。pvbatchは (MPIサポート付きでコンパイルされていれば) mpirun

から起動することが可能な並列アプリケーションです。従って別のサーバに接続す
ることはできず、それ自身がサーバとなっています。一般的には、インタプリタを
対話式に使うなら pvpythonを、並列に実行したい場合は pvbatchを使用します。

ParaViewの Pythonモジュールを、ParaViewの外部のプログラムから使用する
ことも可能です。そのためには、PYTHONPATH環境変数にParaViewのライブラリお
よび Pythonモジュールへのパスを含め、LD LIBRARY PATH (Unix/Linux/Mac)1 ま
たは PATH (Windows) 環境変数を、ParaViewのライブラリへのパスを含むように
設定します。このようにしてPythonスクリプトを実行することで、IDLEのような
サード・パーティのアプリケーションを使用することが可能となります。環境設定
に関するさらなる情報については、ParaView Wikiをご覧下さい。

4.2 パイプラインの作成
ParaViewのためのあらゆるPythonスクリプトが行わなければならない最初のこ
とは、paraview.simpleモジュールの読込みです。これは、以下を実行することに
よって行われます。

from paraview.simple import *

1訳注: Mac OS Xでは DYLD LIBRARY PATH
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一般に、このコマンドはあらゆるParaViewのPythonバッチ・スクリプトで行う必
要があります。このコマンドは ParaViewからスクリプティングのダイアログを起
動した時には自動的に実行されますが、(pvpythonと pvbatchを含む) その他のプ
ログラムでPythonインタプリタを使用する際には、明示的に行う必要があります。
paraview.simpleモジュールによって、ParaViewで定義されているあらゆるソー
ス、読込みオブジェクト、フィルタ、および書出しオブジェクトに対応するPython

の関数が定義されます。この関数名は、GUIのメニューで表示されるそれらの名前か
ら、空白と特殊文字を除いたものとなります。例えば、Sphere関数はGUIのSources

→ Sphereと対応し、PlotOverLine関数は Filters → Data Analysis → Plot Over Line

に対応します。それぞれの関数によってパイプライン・オブジェクトが作成され、(書
出しオブジェクトを除いて) それがパイプライン・ブラウザに表示され、さらにそ
のパイプライン・オブジェクトのプロパティを取得、または操作するためのプロキ
シ・オブジェクトを返します。
paraview.simpleモジュールには、その他の操作を行うための関数もあります。
例えば、Showと Hideの対になった関数は、パイプライン・オブジェクトのビュー
内での表示・非表示を切替えます。Render関数は、ビューの再描画を行います。

演習 4.1: ソースの作成と表示
もし、まだ行っていなければ、メニューからTools → Python Shellを選択し、ParaView

のGUIから Pythonシェルを開いて下さい。この操作によって Pythonシェルを起
動した場合、

from paraview.simple import *

は既に実行されています。
以下をPythonシェルに入力して、Sphereソースを作成および表示させて下さい。

sphere = Sphere()

Show()

Render()

Sphereコマンドによって、スフィア (球) のパイプライン・オブジェクトが作成
されます。Sphereコマンドを実行したら、パイプライン・ブラウザに項目が作成さ
れたのがお判り頂けると思います。このパイプライン・オブジェクトのプロキシは、
sphere変数に格納されています。この変数は (まだ) 使用されていませんが、この
ようにしてパイプライン・オブジェクトへの参照を保持しておくのは良い習慣と言
えます。
つぎの Showコマンドによって、ビュー内でのこのオブジェクトが表示状態とな
り、ついで Renderによって、その結果が見えるようになります。この時点で、再び
GUIを直接インタラクティブに操作できるようになります。ビューの視点の角度を、
マウスによって変更してみて下さい。 �
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演習 4.2: フィルタの作成および表示
フィルタの作成は、ソースの作成とほとんど同様です。デフォルトでは、GUIでフィ
ルタを作成する時と同様に、最後に作成されたパイプライン・オブジェクトが、新
たに作成されたフィルタへの入力としてセットされます。
この演習は、演習 4.1の続きです。この演習を始める前に、演習 4.1を完了させて
おく必要があります。

Pythonシェルに、以下のスクリプトを入力して下さい。このスクリプトは、球を
非表示にしてシュリンク・フィルタを追加し、それを表示します。

Hide()

shrink = Shrink()

Show()

Render()

球は、Shrinkフィルタの出力によって置き換えられます。それによって球を構成
する全てのポリゴンが縮小され、爆発したような見掛けになります。 �

ここまで、パイプラインを構成する際には、デフォルトの設定を適用してきまし
た。しかしながら多くの場合、2章の演習で見られたように、オブジェクト・インス
ペクタを用いて設定を変更する必要があります。

Pythonによるスクリプティングでは、オブジェクトを作成する関数から返される
プロキシを使用して、パイプライン・オブジェクトを操作します。これらのプロキ
シは実際のところ、オブジェクト・インスペクタで設定するプロパティに対応する
クラス属性 (プロパティ) を有する、Pythonのオブジェクトです。それらのプロパ
ティは、オブジェクト・インスペクタの設定名から、スペースやPythonオブジェク
ト名に使用できない文字を除いた名前を有します。それらのプロパティを設定する
には、単に設定したい値を代入します。

演習 4.3: パイプライン・オブジェクトのプロパティを変更する
この演習は、演習 4.1と 4.2の続きです。この演習を始める前に、演習 4.1と 4.2を完
了させておく必要があります。
ここまでに、sphereと shrinkの 2つのPython変数を作成しました。これらは対
応するパイプライン・オブジェクトのプロキシです。それではまず、以下のコマン
ドを Pythonシェルに入力し、球の Theta Resolutionプロパティの値を取得します。

print sphere.ThetaResolution

Pythonインタプリタによって、8の値が返される筈です。(なお、Pythonシェル
は全てのコマンドの実行結果を出力するため、引数の Pythonオブジェクトを標準
出力に表示させる printキーワードは本来、不要です。)　このプロパティの値を
変えて、球の赤道方向のポリゴンの数を倍にしてみましょう。
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sphere.ThetaResolution = 16

Render()

シュリンク・フィルタが持っているプロパティはただ一つ、Shrink Factorです。こ
の設定を調整すると、ポリゴンのサイズが大きく、または小さくなります。この値
を変更して、ポリゴンを小さくしてみましょう。

shrink.ShrinkFactor = 0.25

Render()

Pythonのコマンドを入力してパイプライン・オブジェクトのプロパティを変更す
るのに合わせて、GUIのオブジェクト・インスペクタが更新されるのがお判り頂け
ると思います。 �

ここまで、分岐の無いパイプラインだけを作成してきました。これは単純であり
ながら一般的なケースであり、paraview.simpleモジュールの他の多数の機能と同
様、このようなケースにおける作業量を最小限にとどめつつ、さらに複雑なケース
にも対応できるような明確な道筋を提供できるよう設計されています。ここまで分
岐の無いパイプラインを構成してきたように、直前に作成されたオブジェクトは、
ParaViewによって自動的に次のフィルタの入力として接続されてきました。それに
よって、スクリプトはそれが行う操作の一連の流れとして読むことができるように
なっています。しかしながら、パイプラインに分岐が存在する場合には、フィルタ
の入力を明確に指定する必要があります。

演習 4.4: パイプラインを分岐する
この演習は、演習 4.1から 4.3までの続きです。この演習を始める前に、演習 4.1から
4.2までを完了させておく必要があります (演習 4.3は任意です)。
今までのところ、sphereと shrinkという、2つの Python変数を作成しました。
これらは、対応するパイプライン・オブジェクトのプロキシとなっています。ここ
で、球のワイヤーフレームを抽出する 2つめのフィルタをスフィア・ソースに追加
しましょう。以下を Pythonシェルに入力してください。

wireframe = ExtractEdges(Input=sphere)

Show()

Render()

スフィア・ソースに、Extract Edgesフィルタが追加されました。元の球のワイヤー
フレームと、ポリゴンが縮小された球が同時に表示されている筈です。
ここで、ExtractEdges関数への引数として Input=sphereを与えることで、Ex-

tract Edgesフィルタへの入力を明示的に指定していることに注意してください。こ
こで実際に行われていることは、オブジェクトを作成する際に、Inputプロパティ
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を与えることです。デフォルトの入力でオブジェクトを作成し、後で与えることも
可能ですが、推奨されません。それは、全てのフィルタが全ての種類の入力を受付
ける訳ではないためです2。もし最初に誤った種類の入力によってフィルタを作成し
た場合、Inputプロパティを正しい種類の入力に変更する機会を得る前に、エラー
メッセージが表示されることとなる可能性があります。
出力に 2つのフィルタが接続されているスフィア・ソースは、扇型に広がるパイプ
ラインの例です。このように 1つの出力に複数のフィルタを接続することは、常に
可能です。一方で、全てではないものの、いくつかのフィルタは入力に複数のフィ
ルタを接続することが可能です。複数のフィルタを入力に接続することは、扇型に
束ねる接続と言えます。ParaViewのPythonスクリプティングでは、扇型に束ねる
ことは扇型に広げることと同様に、フィルタへの入力を明示的に指定することで行
います。(1つの入力ポートに)複数の入力を接続するには、今まで 1つの入力を指定
してきたところに、かわりにパイプライン・オブジェクトのリストを指定します。例
えば、シュリンク・フィルタとエッジの抽出フィルタの出力を、Group Datasetsフィ
ルタを使って束ねてみましょう。以下の行を Pythonシェルに入力して下さい。

group = GroupDatasets(Input=[shrink,wireframe])

Show()

シュリンク・フィルタとエッジの抽出フィルタの結果を表示させておく理由はも
はやありませんので、非表示にしましょう。デフォルトでは、Show関数と Hide関
数は、(フィルタを作成する際のデフォルトの入力と同様に) 最後に作成されたパイ
プライン・オブジェクトに対して作用しますが、引数に与えることで明示的にオブ
ジェクトを選択することができます。シュリンク・フィルタとエッジの抽出フィル
タの結果を非表示とするには、以下を Pythonシェルに入力してください3。

Hide(shrink)

Hide(wireframe)

Render()

�

前述の演習では、オブジェクトを作成する関数の引数を Input=〈入力オブジェク
ト〉とすることで、Inputプロパティを指定できることを述べました。一般的にはど
のようなプロパティでも、〈プロパティ名〉=〈プロパティの値〉と指定することで、オ
ブジェクトの作成時に指定することができます。例えば、以下のような行によって、
球の作成時に Theta Resolutionと Phi Resolutionの双方を指定することができます。

sphere = Sphere(ThetaResolution=360, PhiResolution=180)

2訳注: たとえば、ParticleTracerフィルタへの入力は、Temporalタイプのデータセットである必
要があります。

3訳注: Group Datasetsの実行によって二重に表示されていたオブジェクトが非表示となるだけな
ので、ビューの見掛けは変わりません。
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4.3 アクティブなオブジェクト
ParaViewのGUIを使った経験が少しでもあれば、アクティブなオブジェクトの
概念には既に慣れていることでしょう。GUIによって可視化パイプラインの作成や
操作を行うには、まずパイプライン・ブラウザでオブジェクトを選択する必要があ
ります。それ以外のオブジェクト・インスペクタのようなGUIパネルは、アクティ
ブなオブジェクトが何であるかによって変わります。アクティブなオブジェクトは、
フィルタの追加のような操作でも、デフォルトのオブジェクトとして使用されます。

Pythonによるバッチ・スクリプティングにおいても、アクティブ・オブジェクト
の概念があります。実際、GUIとPythonインタプリタを同時に使用する場合には、
両者は同じアクティブなオブジェクトを共有しています。前節でフィルタを作成した
際、それらのフィルタに与えられるデフォルトの入力が、実はアクティブなオブジェ
クトです。新たなパイプライン・オブジェクトを作成したとき、(GUIでオブジェク
トを作成した時と同じように) その新たなオブジェクトがアクティブとなりました。
アクティブなオブジェクトは、GetActiveSourceおよび SetActiveSource関数に
よって、それぞれ取得および設定することができます。また、GetSources関数によっ
て、全てのパイプライン・オブジェクトのリストを取得することも可能です。GUIのパ
イプライン・ブラウザで新たなオブジェクトをクリックすると、Pythonでのアクティ
ブなオブジェクトもそのオブジェクトに変更されます。同様に、SetActiveSource

を Pythonから呼び出すと、パイプライン・ブラウザでは対応する項目がハイライ
トされます。

演習 4.5: アクティブなパイプライン・オブジェクトを試す
この演習は、前節の演習のつづきです。ただし、好みに応じて、いずれかのオブジェ
クトを適宜作成して、この続きを行うことも可能です。
以下によって、アクティブ・オブジェクトについて色々試してみて下さい。

• GetSources()を呼び出して、オブジェクトのリストを取得して下さい。その
リストの中から、作成したソースとフィルタを探して下さい。

• GetActiveSource()を呼び出して、アクティブなオブジェクトを取得して下
さい。それを、パイプライン・ブラウザで選択されているオブジェクトと比べ
て下さい。

• パイプライン・ブラウザでいずれかの新たなオブジェクトを選択し、GetAc-

tiveSource()を再び呼び出して下さい。

• SetActiveSource関数によって、アクティブなオブジェクトを変更して下さ
い。パイプライン・ブラウザで、その変更を観察して下さい。

�
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アクティブなパイプライン・オブジェクトを保持するのに加えて、ParaViewの
Pythonスクリプティングでは、アクティブなビューも保持しています。ParaView

のユーザであるということで、既に複数ビューとアクティブ・ビューの概念にも慣れ
ていることでしょう。アクティブなビューは、GUIでは青いボーダーラインでマー
キングされています。Python関数の GetActiveViewと SetActiveViewによって、
アクティブなビューを問い合わせたり、変更することができます。パイプライン・オ
ブジェクトと同様に、アクティブなビューはGUIとPythonインタプリタの間で同
期しています。

4.4 オンライン・ヘルプ
The ParaView Book や ParaView Wikiでの似たような使用説明と同様に、この
チュートリアルは、Pythonによるバッチ処理スクリプトを理解し、また作成するた
めに必要な重要な概念を提示することを目的に作成されています。利用可能な関数、
クラス、プロパティの一覧などのドキュメントの詳細は、ParaViewをビルドする過
程において作成され、ParaViewアプリケーションのオンラインヘルプとして提供さ
れています。このようにして、ドキュメントがいかなるバージョンの ParaViewで
あっても最新であり、容易にアクセス可能であることを確実としています。

ParaViewのPythonバインディングでは、help内蔵関数を利用しています。この
関数はあらゆる Pythonオブジェクトを引数に取り、そのオブジェクトに関する何
らかのドキュメントを返します。例えば、以下を入力すると、

help(paraview.simple)

paraview.simpleについての簡単な記述と、paraview.simpleモジュールに含まれ
る全ての関数のリストを、それぞれの概要とともに返します。さらに、たとえば、

help(Sphere)

sphere = Sphere()

help(sphere)

とすると、最初の行では Sphere関数に関するヘルプを表示し、つぎに Sphere関数
を使用してオブジェクトを作成し、さらに Sphere関数によって返されたオブジェク
トに関するヘルプを (そのプロキシの全てのプロパティのリストとともに) 表示し
ます。
オブジェクト・インスペクタの Propertiesタブに表示されるパネルのほとんどは、

Pythonクラスを構築するのと同じ仕組みによって、自動的に生成されます。(使い
やすさを向上させるため、少数ながら例外的に、カスタム・パネルを使用している
ものもあります。) したがって、オブジェクト・インスペクタ上の名前が付けられた
ウイジェットには多くの場合、Pythonオブジェクトにも同じ名前の対応するプロパ
ティが存在しています。
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GUIにパイプライン・オブジェクトのカスタム・パネルが含まれるか否かにかか
わらず、そのオブジェクトのプロパティに関する情報を、GUIのオンライン・ヘル
プで得ることができます。いつものように、ツールバー・ボタンの によって、ヘ
ルプを表示させてください。ヘルプの Contentsの中の Sources Menu、Filters Menu、
ReadersおよびWriters項目の下には、全ての利用可能なオブジェクトに関するドキュ
メントがあります。それぞれの項目には、そのタイプのオブジェクトのリストがあり
ます。いずれのオブジェクトをクリックしても、Pythonから設定可能なプロパティ
のリストを得ることができます。

4.5 ファイルからの読込み
ParaViewのGUIでファイルを開くことと同等の処理は、Pythonスクリプティン
グでは読込みオブジェクトを作成することです。読込みオブジェクトは、ソースや
フィルタとほぼ同様にして作成します。paraview.simpleには、それぞれの読込み
オブジェクトの種類について、パイプライン・オブジェクトを作成してプロキシ・
オブジェクトを返す関数が含まれています。
全ての読込みオブジェクトには少なくとも、ファイル名を指定するための (GUIか
らは見えない) プロパティがあります。このプロパティは慣習的に、FileNameまた
は FileNamesと呼ばれています。読込みオブジェクトを作成する際には、オブジェ
クトのコンストラクタへの引数で FileName=〈ファイルへのフル・パス〉のように記
述することで、必ず有効なファイル名を与える必要があります。有効なファイル名
が与えられないと、読込みオブジェクトは多くの場合、正しく初期化されません。

演習 4.6: 読込みオブジェクトの作成
本演習ではまっさらな状態から可視化を行いますので、ここまでの演習を行ってこら
れた場合は、ParaViewを再起動するのにちょうど良いタイミングでしょう。そのた
めの最も簡単な方法は、 ボタンを押すことです。また、Pythonシェルも必要で
す。もしまだ行っていなければ、メニューからTools → Python ShellとしてPython

シェルを開いて下さい。
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この演習では、Pythonシェルから disk out ref.ex2を読込みます。コンピュータ内
の disk out ref.ex2ファイルを探し、そのパスをPythonシェルに入力するかコピーで
きるようにして下さい。このファイルを以後、〈パス〉/disk out ref.ex2とします。
以下を Pythonシェルに入力し、ファイル名を指定しつつ読込みオブジェクトを
作成します。

reader = ExodusIIReader(FileName=’〈パス〉/disk_out_ref.ex2’)

Show()

Render()

�

4.6 フィールドの属性を問合せる
全てのパイプライン・オブジェクトのためのプロキシは、そのクラスに特定のプ
ロパティに加えて、共通のプロパティやメソッドを持っています。そのようなプロパ
ティの中でも特に重要な 2つのプロパティは、PointDataプロパティと CellDataプ
ロパティです。これらのプロパティは、Pythonにおける連想配列型である辞書のよ
うに振舞います。すなわち、(文字列で表された) 変数名を、フィールドの何らかの
特性を保持する ArrayInformationオブジェクトにマッピングします。ここで特記
しておくべきは、ArrayInformationのメソッドである GetNameで、これはフィー
ルドの名前を返します。GetNumberOfComponentsメソッドは、それぞれのフィール
ド値の成分の数 (スカラなら 1、ベクトルならそれ以上) を返します。GetRangeメ
ソッドは、ある特定の成分の最小値および最大値を返します。

演習 4.7: フィールド情報の取得
この演習は演習 4.6のつづきです。この演習を始める前に、演習 4.6を完了する必要
があります。
まず、節点型データへのハンドルを取得し、データが持つ全ての節点型フィール
ドを表示します。

pd = reader.PointData

print pd.keys()

“Pres”と “V”フィールドに関する情報を取得します。

print pd[’Pres’].GetNumberOfComponents()

print pd[’Pres’].GetRange()

print pd[’V’].GetNumberOfComponents()

それでは、もう少し凝ったことを試してみましょう。Pythonの for構文を使って、
全ての配列の全ての成分について、値の範囲を表示させます。
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for ai in pd.values():

print ai.GetName(), ai.GetNumberOfComponents(),

for i in xrange(ai.GetNumberOfComponents()):

print ai.GetRange(i),

print

�

4.7 レプレゼンテーション
レプレゼンテーションは、パイプライン・オブジェクト内のデータとビューを結び
つける役割を果たします。レプレゼンテーションによって、どのようにデータセッ
トがビュー内で描画されるかが管理されます。レプレゼンテーョンによって、配色
やライティングのようなレンダリングにおけるプロパティに加え、データの描画に
用いられる内部的なレンダリング・オブジェクトが定義および管理されます。GUI

のDisplayパネルにおいて設定可能なパラメータは、レプレゼンテーションによって
決まります。全てのパイプライン・オブジェクトとビューのペアについて、個別の
レプレゼンテーション・オブジェクトのインスタンスが存在します。これは、それ
ぞれのビューがデータを異なったレプレゼンテーションで表示できるようにするた
めです。
レプレゼンテーションは、自動的に作成されます。GetRepresentation関数によっ
て、レプレゼンテーション・オブジェクトへのプロキシを取得することができます。
引数が何も無ければ、この関数はアクティブなパイプライン・オブジェクトおよび
アクティブなビューに関するレプレゼンテーションを返します。パイプライン・オ
ブジェクトまたはビュー、あるいはそれら両方を指定することも可能です。

演習 4.8: データの色づけ
この演習は、演習 4.6のつづきです。まだ演習 4.6での Exodusファイルを開いてい
なければ、この演習の前に演習 4.6を完了させて下さい。
形状の色を青色に変更し、鏡面反射によるハイライトをかなり強めに与えます (つ
まり、その形状に強い光沢を与えます)。Pythonシェルに以下を入力し、レプレゼ
ンテーションを取得して材質の特性を変更します。

readerRep = GetRepresentation()

readerRep.DiffuseColor = [0, 0, 1]

readerRep.SpecularColor = [1, 1, 1]

readerRep.SpecularPower = 200

readerRep.Specular = 1

Render()
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GUI上でマウスによってカメラを回転し、鏡面反射によるハイライトの効果を確
かめて下さい。
レプレゼンテーションは、フィールド変数によって色付けするためにも使うこと
ができます。以下を Pythonシェルに入力し、“Pres”フィールド変数によってメッ
シュを色付けして下さい。

readerRep.ColorArrayName = ’Pres’

readerRep.LookupTable = MakeBlueToRedLT(0, 0.03)

Render()

�
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このチュートリアルに参加頂き、ありがとうございました。ParaViewを使って、
大規模データの可視化を始めるのに充分なだけ勉強されたことでしょう。以下には、
さらに情報を得るための情報源を挙げます。

The ParaView Guideは、ParaViewと一緒に持っておくのにとても良い情報源で
す。ここで学んだ以外の多くの使用法や、多くの機能に関するより詳細な説明が得
られます。

Amy Henderson Squillacote. The ParaView Guide. Kitware, Inc., 2008. ISBN-10

1-930934-21-1.

ParaView Wikiは、ParaViewをセットアップして使用するのに役立つ情報が満載
です。特に、並列 ParaViewサーバをインストールしたい方は、そのためのビルド
およびインストールのページを必ずご参照ください。

http://www.paraview.org/Wiki/ParaView

http://www.paraview.org/Wiki/Setting up a ParaView Server

可視化や、ParaViewで利用可能なフィルタに関する詳細事項をさらに学ぶことに
興味がある場合は、以下の可視化に関するテキストを入手することをご一考下さい。

Will Schroeder, Ken Martin, and Bill Lorensen. The Visualization Toolkit. Kit-

ware, Inc., fourth edition, 2006. ISBN 1-930934-19-X.

ParaViewをカスタマイズしようとされているのであれば、上記の本およびウエブ・
ページに多くの情報があります。ParaViewが依存する可視化ライブラリの VTK、
GUIライブラリのQtの使用法に関する情報については、下記の本が参考となります。

Kitware Inc. The VTK Users Guide. Kitware, Inc., 2006.

Jasmin Blanchette and Mark Summerfield. C++ GUI Programming with Qt 4.

Prentice Hall, 2006. ISBN 0-13-187249-4 (邦訳: 杵渕 聡、杉田 研治 訳「入門
Qt 4 プログラミング」オライリー・ジャパン、2007年、ISBN 978-4-87311-

344-9).

http://www.paraview.org/Wiki/ParaView
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server
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もし並列可視化の設計や VTKパイプラインの機能に興味があるのであれば、以
下の技術論文があります。

James Ahrens, Charles Law, Will Schroeder, Ken Martin, and Michael Papka.“A

Parallel Approach for Efficiently Visualizing Extremely Large, Time-Varying

Datasets.”Technical Report #LAUR-00-1620, Los Alamos National Labora-

tory, 2000.

James Ahrens, Kristi Brislawn, Ken Martin, Berk Geveci, C. Charles Law, and

Michael Papka.“Large-Scale Data Visualization Using Parallel Data Stream-

ing.”IEEE Computer Graphics and Applications, 21(4): 34–41, July/August

2001.

Andy Cedilnik, Berk Geveci, Kenneth Moreland, James Ahrens, and Jean Farve.

“Remote Large Data Visualization in the ParaView Framework.”Eurographics

Parallel Graphics and Visualization 2006, pg. 163–170, May 2006.

James P. Ahrens, Nehal Desai, Patrick S. McCormic, Ken Martin, and Jonathan

Woodring. “ A Modular, Extensible Visualization System Architecture for

Culled, Prioritized Data Streaming.”Visualization and Data Analysis 2007,

Proceedings of SPIE-IS&T Electronic Imaging, pg 64950I-1–12, January 2007.

John Biddiscombe, Berk Geveci, Ken Martin, Kenneth Moreland, and David

Thompson. “ Time Dependent Processing in a Parallel Pipeline Architec-

ture.”IEEE Visualization 2007. October 2007.

もし ParaViewの並列レンダリングのアルゴリズムや構造に興味があるのであれ
ば、それらに関する技術論文もまた多数あります。

Kenneth Moreland, Brian Wylie, and Constantine Pavlakos.“ Sort-Last Parallel

Rendering for Viewing Extremely Large Data Sets on Tile Displays.”Pro-

ceedings of IEEE 2001 Symposium on Parallel and Large-Data Visualization

and Graphics, pg. 85–92, October 2001.

Kenneth Moreland and David Thompson.“From Cluster to Wall with VTK.”Pro-

ceddings of IEEE 2003 Symposium on Parallel and Large-Data Visualization

and Graphics, pg. 25–31, October 2003.

Kenneth Moreland, Lisa Avila, and Lee Ann Fisk.“Parallel Unstructured Volume

Rendering in ParaView.”Visualization and Data Analysis 2007, Proceedings

of SPIE-IS&T Electronic Imaging, pg. 64950F-1–12, January 2007.
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2分木法, 69

3D View, 8

3Dウィジェット, 27

3Dビュー, 8

AMR, 5

annotate time, 48

ArrayInformation, 84

calculator, 15, 64

CellData, 84

client collect, 72

clip, 15, 19, 21, 27, 63, 66

compositing threshold, 72

contour, 15, 17, 64–66

cut, see slice

Display, 8

extract surface, 18

extract group, 15

extract subset, 15

extract group, 15, 64

extract selection, 43

extract subset, 15, 63, 66

ExtractEdges, 79

for, 84

GetActiveSource, 81

GetActiveView, 82

GetName, 84

GetNumberOfComponents, 84

GetRange, 84

GetRepresentation, 85

GetSources, 81

glyph, 15, 25, 32, 64

group, 15, 65

group datasets, 15

GroupDatasets, 80

help, 82

Hide, 77, 78, 80

histogram, 30

IceT, 69

immediate mode rendering, 68

Information, 8

LOD, 67

LOD Threshold, 68

LODしき い値, 68

object inspector, 8

ordered compositing, 71

ParaView, 1

paraview.simple, 82

ParaViewサーバ, 2

pipeline browser, 8

PlotOverLine, 77

plot over line, 27

plot selection over time, 42

PointData, 84

Properties, 8

pvpython, 2

remote render threshold, 71

Render, 77, 78

rendering interrupts, 68

SetActiveSource, 81
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SetActiveView, 82

Show, 77, 78, 80

Shrink, 78

slice, 15, 64, 66

Sphere, 77, 82

SQUIRT, 71

stream tracer, 15

stream tracer, 15, 24, 31, 64

subsample, 71

threshold, 15, 63, 66

triangle strips, 68

tube, 25, 32

Visualization Toolkit, 2

VTK, 2

warp

vector, 15, 64

しきい 値, 15

アクティブなビュー, 21

アニメーション・ビュー, 43

アノーテート・タイム, 47, 48

イミディエイト・モード・レンダリン
グ, 68

インタラクティブ・レンダー, 67

オブジェクト・インスペクタ, 8

カット, see スライス
カメラのリセット, 24

カメラのリンク, 22

キー・フレーム, 49

クイック起動, 16

クライアント, 54

クライアント－サーバ, 55

クライアント－レンダー・サーバ－デー
タ・サーバ, 55

クライアントに集約する, 72

クリップ, 15

グリフ, 15

グループの抽出, 15

コンター, 15

ゴースト・セル, 59

サブセットの抽出, 15

シード点, 24

スタンドアローン, 54

スティル・レンダー, 67

スプレッドシート・ビュー, 39

スライス, 15

セレクション・インスペクタ, 38

ソース, 8

ソート・ラスト, 69

チューブの生成, 25

ツールバー, 8

テキスト・ソース, 46

テンポラル・インターポレータ, 45

データ・サーバ, 54

データセットのグループ化, 15

データ型, 3

ディテールのレベル, 67

トライアングル・ストリップ, 68

トラック, 49

ドック可能な, 8

バイナリ・スワップ法, 69

パイプライン・ブラウザ, 8

ヒストグラム, 30

ビルトイン, 54

フィルタ, 3, 14

ボリューム・レンダリング, 30

ポリゴン・データ (ポリ・データ), 4

マルチブロック, 5

メニューバー, 8

モード, 43

ラバー・バンド, 36

リモート・レンダリングを行うし きい
値, 71

レプレゼンテーション, 85

レンダー・サーバ, 54

レンダリングの中断, 68

ワープ
ベクトル, 15
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一様直線格子 (画像データ), 4

可視化パイプライン, 14, 18

階層化一様AMR, 5

階層化適応メッシュ分割, 5

外部界面, 58

間引き, 71

曲線格子 (構造格子), 4

空間的にコヒーレントな, 59

辞書, 84

重畳, 69

重畳を行うしきい値, 72

順序付け重畳, 71

小面, 9

制御点, 33

扇型に広がる, 80

扇型に束ねる, 80

浅いコピー, 62

線分上の値のプロット, 27

選択部分の 抽出, 43

選択部分を時間に沿って プロット, 42

伝達関数, 32

電卓, 15

等値面, 15

八分木, 5

非一様直線格子 (直線格子), 4

非構造格子, 5

表示・非表示, 20

表面の抽出, 18

流線, 24

流線追跡, 15

シード点, 24

連結状態, 20
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